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InstallAnywhere 2021 SP1 Help
Library

InstallAnywhere 2021 SP1

InstallAnywhere is a multiplatform installation development solution for application producers who need to
deliver a professional and consistent installation experience for physical, virtual, and cloud environments. From a
single project file and build environment, InstallAnywhere creates reliable installations for on-premises
platforms—Windows, Linux, macOS and OS X, Solaris, AlX, HP-UX, IBM iSeries—and enables you to deploy your
products into cloud and virtual environments.

Information about using InstallAnywhere is presented in the following sections:

Table 1-1 = InstallAnywhere Help Library

Section Description

What is New in InstallAnywhere Informs you about changes the changes in InstallAnywhere 2021 SP1.

2021 SP1

What Was New in Earlier Informs you about changes that were made in earlier versions of in

Versions of InstallAnywhere InstallAnywhere.

Using Help Provides information about the InstallAnywhere documentation.

Getting Started Describes the InstallAnywhere interface authoring environments and
explains how to begin creating an installation project.

Concepts of InstallAnywhere Introduces you to the basic and advanced concepts of InstallAnywhere

Installer Development installation development.

InstallAnywhere Tutorial Provides guided exercises to explore using InstallAnywhere.

Creating Basic Installers Provides procedures and suggestions about common situations when using

InstallAnywhere to build a basic installer.
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Legal Information

Table 1-1 = InstallAnywhere Help Library (cont.)

Section Description

Adding Advanced Functionality  Explains how to add more advanced procedures to an InstallAnywhere
to Installers installer.

Updating Applications Describes how to create update installers for applications.

Creating Virtual Appliances Explains how to use an existing InstallAnywhere project to build virtual
appliances for cloud platforms such as Amazon EC2 and VMware vSphere.

Creating Docker Containers Explains how to use an existing InstallAnywhere project to configure and
build Docker containers along with your traditional multiplatform installers.

Using FlexNet Code Aware to Describes FlexNet Code Aware, an automated open source risk assessment
Perform Open Source Risk and package discovery solution that enables you to quickly scan your
Assessment products for security and intellectual property (IP) compliance risk.
Reference Contains comprehensive reference information for the InstallAnywhere user

interface; available actions that define operations that an installation
performs; parameters for the command-line tools that enable you to
perform tasks such as building or running an installation; the Ant task for
building installations; custom code APIs for automating development and
testing of installations; and more.

Legal Information
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InstallAnywhere 2021 SP1

Copyright Notice
Copyright © 2020 Flexera Software

This publication contains proprietary and confidential information and creative works owned by Flexera Software
and its licensors, if any. Any use, copying, publication, distribution, display, modification, or transmission of such
publication in whole or in part in any form or by any means without the prior express written permission of Flexera
Software is strictly prohibited. Except where expressly provided by Flexera Software in writing, possession of this
publication shall not be construed to confer any license or rights under any Flexera Software intellectual property
rights, whether by estoppel, implication, or otherwise.

All copies of the technology and related information, if allowed by Flexera Software, must display this notice of
copyright and ownership in full.

Intellectual Property

For a list of trademarks and patents that are owned by Flexera Software, see https://www.revenera.com/legal/

intellectual-property.html. All other brand and product names mentioned in Flexera Software products, product
documentation, and marketing materials are the trademarks and registered trademarks of their respective
owners.
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What is New in InstallAnywhere 2021 SP1

Restricted Rights Legend

The Software is commercial computer software. If the user or licensee of the Software is an agency, department,
or other entity of the United States Government, the use, duplication, reproduction, release, modification,
disclosure, or transfer of the Software, or any related documentation of any kind, including technical data and
manuals, is restricted by a license agreement or by the terms of this Agreement in accordance with Federal
Acquisition Regulation 12.212 for civilian purposes and Defense Federal Acquisition Regulation Supplement
227.7202 for military purposes. The Software was developed fully at private expense. All other use is prohibited.

Third-Party Licenses

InstallAnywhere uses and redistributes some third-party code. The licenses required for such code are installed in

the InstallAnywhere folder.

Table 1-2 = Third-Party Licenses

License Location in InstallAnywhere’s Installation Directory

ICU License /licenses/ICU-License.htm
ICU 1.8.1 and later

jTDS GNU /resource/db/drivers/jTDS/LICENSE.TXT
Lesser General Public License

PostgreSQL /resource/db/drivers/PostgreSQL/LICENSE.TXT
Global Development Group License

Third-Party Licenses /licenses/thirdpartylicences.rtf
Listing of all third-party licenses

What is New in InstallAnywhere 2021 SP1

InstallAnywhere 2021 includes the following new features:
® New Features in InstallAnywhere 2021 SP1

® New Features in InstallAnywhere 2021

New Features in InstallAnywhere 2021 SP1

InstallAnywhere 2021 SP1 includes the following new features and enhancements:
® Support for Windows Server 2022

® Codesign with the “Developer ID Application:” String

Support for Windows Server 2022

Now, the Installer runs on Windows Server 2022 machine as well with all Java version.
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What Was New in Earlier Versions of InstallAnywhere

Codesign with the “Developer ID Application:” String

Now, the macOS installer supports codesigning with “Developer ID Application:” string for the certificate name.

New Features in InstallAnywhere 2021

InstallAnywhere 2021 includes the following new features and enhancements:
® Support of File Associations in Windows

® Support for 8.3 File Naming

Support of File Associations in Windows

In InstallAnywhere 2021, new Action has been added to handle File Associations on Windows platforms. This
Action is available for all project types. New Action “Associate File Extension - Windows” is added to Install Phase
& Post- Install Phase. It is available at:

e Sequence > Install > Add Action > General

® Sequence > Post-Install > Add Action > General

Support for 8.3 File Naming

You can now enable 8.3 file naming for all volumes with elevated privileges for Windows target machines. Added
new action “Enable 8.3 File Naming Action” to enable 8.3 naming for all volumes and added a new variable
“$IA_8DOT3_FILENAMECREATION_STATE$” to identify whether the 8.3 File creation is enabled or not for all
volumes.

What Was New in Earlier Versions of
InstallAnywhere

20

InstallAnywhere 2021 SP1

This section describes features and enhancements that were released in earlier versions of InstallAnywhere:
® What’s New in InstallAnywhere 2020 SP2

® What’s New in InstallAnywhere 2020 SP1

® What’s New in InstallAnywhere 2020

® What’s New in InstallAnywhere 2018 SP1

® What’s New in InstallAnywhere 2018

® What’s New in InstallAnywhere 2017 SP1

® What’s New in InstallAnywhere 2017

® What’s New in InstallAnywhere 2015 SP1

® What’s New in InstallAnywhere 2015

® What’s New in InstallAnywhere 2014 SP1
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What Was New in Earlier Versions of InstallAnywhere

® What’s New in InstallAnywhere 2014

® What’s New in InstallAnywhere 2013

What’s New in InstallAnywhere 2020 SP2

InstallAnywhere 2020 SP2 includes the following change:

® Option to Turn-Off the Application of File Attributes

® Enable Silent and Console Mode by Default for Basic Template
® Running InstallAnywhere SAB within a Docker container

® Easier Merges of Project Files

® Configure the Panel: Choose File

Addition of a New Variable Containing Invocation User Details

Option to Turn-Off the Application of File Attributes

Now in InstallAnywhere 2020 SP2, the options has been added to handle File Attributes changes for Installer,
Uninstaller, and Launchers. The following fields are added:

o Apply Installer File Attributes - This field is added under Project > Platforms > Windows section for all
project types. By default, the value is set to Yes. The value can be set to No to stop File Attributes changes for
windows Installer.

o Apply Uninstaller/Launcher File Attributes - This field is added under Project > Platforms > Windows section
for all project types. By default, the value is set to Yes. The value can be set to No to stop File Attributes
changes for Uninstaller and Launchers.
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InstallAnywhere 2020 - My_Product_94 (My_Product_94.iap_xml) - O X
File  Edit Help  Buy Now
InstallAnyWhere < Project [ Installer UI 2 Organization i= Sequence « Build @
$x General Settings
[ Default 05X UI Mode ~
(=) (i Installer Ul Mode GUI -l
Uninstaller Ul Mode <Same as Installer> -l
=] Windows
Default Install Folder Programs Folder ~ |\ $PRODUCT_NAMES
Default Shortcut Folder Programs Menu ~ |\ $PRODUCT_NAMES
e Specity the Launcher IV Sertings on & 64-Bit Machine Use 64-BIt VM, if not available use 32-Bit JVM =l
& 1M settings Windows Execution Level Highest Available |
Estimated Size (in ME)
<& Variables Apply Installer File Attributes Yes =l
Apply Uninstaller/Launcher File Attributes Yes |
= Advanced El Default Windows Ul Mode
Installer Ul Mode Gul =l
[ Upgrades Uninstalier Ul Mode <Same as Installers -l
) Digital Signing
Certificate Information ]
Timestamp Server
Password
£ UNIX
Default Install Felder Programs Folder ~ | / $PRODUCT_NAMES
Default Link Folder Home Directory =/
=) Default Unix Installer Ul Mode v
Enter the title that you want to display in the title bar of the installers that are built from the project.

Enable Silent and Console Mode by Default for Basic Template

Previously, the silent and console mode were not selected by default when a new project was created. Now, the
silent and console mode are enabled by default while creating a new project.

Note = This change was tracked in issue 10J-2109343.

Running InstallAnywhere SAB within a Docker container

Added instruction to install SAB build as well as register the license within a Docker container. For more detail,
see Knowledge Base article.

Note = This change was tracked in issue 10J-2092582.

Easier Merges of Project Files

Modified the format and design of the project files to allow the easier merges of project files from the different
branches in source control.

Note = This change was tracked in issues 10J-1995786 and 10J-1560334.
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Configure the Panel: Choose File

Previously, all the files were displayed in the Choose File panel. Now, you can configure the Panel to filter by file
type and display only a specific file type.

Note = This change was tracked in issue 10J-1925434.

Addition of a New Variable Containing Invocation User Details

Added a new variable “ia.mac.invoked.user” to store the user name of the invoked user who launched the
authenticated installer, before the installer is elevated to run as the root user.

This change was tracked in issue 10J-1739950.

What’s New in InstallAnywhere 2020 SP1

InstallAnywhere 2020 SP1 includes the following new features and enhancements:
® Advanced JRE Handling for Version Upgrades

® Horizontal/Vertical Scrolling Available on Custom Panels

Advanced JRE Handling for Version Upgrades

If you are creating an upgrade installer that contains a JRE with a different processor type or version than the
previous version of the installer, problems could occur during installation of that JRE.

In InstallAnywhere 2020 SP1, a new option has been added to prevent those problems from occurring: the
Advanced JRE handling for Version Upgrades option on the Project > Installer Settings tab of the JVM Settings
view.

Selecting the Advanced JRE handling for Version Upgrades option will enable Maintenance Mode and Instance
Management Panels to display the existing instances of the same product across both 32-bits and 64-bits. If this
option is not selected, the panels will display only instances which correspond to the bits of the upgrade installer.

The following are scenarios when you should select this option:

® New installer has a JRE with a different processor type than previous—For example, you are currently
building App A V2 with a 64-bit JRE version X, but App A V1 had a 32-bit JRE version X.

e New installer has a JRE with a different version than previous—For example, you are currently building App
A V2 with a 64/32-bit JRE version X, but App A V1 had a 64/32-bit JRE version Y.

Horizontal/Vertical Scrolling Available on Custom Panels

Using InstallAnywhere’s custom code API enables you to create custom panels where necessary. In
InstallAnywhere 2020 SP1, you can now enable vertical or horizontal scrolling on custom panels.

To specify vertical or horizontal scrolling on a custom panel, select the Enable Vertical Scroll or Enable Horizontal
Scroll option in the Properties Customizer for that panel on the Pre-Install view of the Sequence page.
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InstallAnywhere 2020 includes the following new features and enhancements:
® Support for Java 13

® Mac 0S X Notarization

® Support for Digital Signature using Windows Store

e JVM Specification Files for Java 10 and 11

® HTTPS Protocol Option in Download File Action

® Warning for an Invalid Java VM

® Support for InstallAnywhere Registration and License

Support for Java 13

InstallAnywhere 2020 now supports the latest version of Java, Version 13.
Using InstallAnywhere 2020, you can:

® C(Create Java 13 VM packs

® Create installers which uses bundled Java 13 VM pack

® C(Create installers that can detect a Java 13 on the host and run automatically

Mac 0S X Notarization

Starting in mac0S 10.14.5, all new or updated kernel extensions and all products from developers new to
dispersing with Developer ID must be notarized so as to run. Starting in mac0S 10.15, by default, the notarization
is required for all products.

Notarization likewise ensures your users if your Developer ID signing key is uncovered. The notary service keeps
up a review trail of the product appropriated utilizing your signing key.

In InstallAnywhere 2020, you can automatically notarize your application with ease. InstallAnywhere now
supports notarizing macOS or OS X-based installers with a Developer ID Application certificate during the build
time.

The process of notarizing your authentication wrappers, your installers, and your uninstallers varies, depending
on whether you are performing the notarizing step at build time on the InstallAnywhere build machine or on a
separate designated notarization machine.

You can specify whether and how you want InstallAnywhere to notarize your OS X-based installer at build time. If
you notarize the installer, end users can download your installer from outside the Mac App Store and install the
product without being blocked by the Gatekeeper. The App NOTARIZATION settings in this area are:

® Notarize the Generated Installer
e Developer Username
o Developer App Specific Password

® Notarization Response Timeout(min)
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e Notarization Process Delay Interval(sec)

Support for Digital Signature using Windows Store

InstallAnywhere 2020 provides the Certificate Selection dialog box to specify which certificate you want to use to
sign your files. InstallAnywhere lets you choose between the following options:

® You can specify the .pfx certificate file on your machine that you want to use for signing.

® You can reference a certificate store that contains the certificate that you want to use for signing.

JVM Specification Files for Java 10 and 11

Now in InstallAnywhere 2020, you have JVM specification files available for Java 10 and 11 in the default folder
($IA_HOMES$/resource/jvms).

HTTPS Protocol Option in Download File Action

You can now use the Download File action to download a file during installation using HTTPS protocol. You specify
information regarding this action on the Download File Action customizer.

Warning for an Invalid Java VM

Previously, there was no warning/caution message displayed while selecting a Java VM which was not valid for
the InstallAnywhere installation.

In this release, there will be an error message when you select a Java VM that is not on the valid VM list from the
Choose Java VM panel.

Support for InstallAnywhere Registration and License

Previously, there was no message whether or not InstallAnywhere was registered or licensed when building a
project.

Now in InstallAnywhere, you have a command output that will display that determines whether your copy of
InstallAnywhere is registered and licensed while building the project.

What’s New in InstallAnywhere 2018 SP1

For information about new features and enhancements added in InstallAnywhere 2018 SP1, refer to the following
sections:

® Configure Installer Updates

® Support for Java 11

® Improved Designer Search & Expanded Search Functionality

® Ability to Provide a Simple Way to get a Feature's Long Name from its Short Name
® Ability to Hold the Path for Global InstallAnywhere Registry Location

e Allow Alignment of Input Fields for Get User Input Panel

® Ability to Support tar.gz and tar.z
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® Ability to Read REG_MULTI_SZ Values from Get Windows Registry Entry Action
® Option to Set Size field via InstallAnywhere Project for Add or Remove Programs Applet on Windows

® Ability to Set Installer Title Image on a Linux and MAC Machine for Windows Build Target

Configure Installer Updates

In InstallAnywhere 2018 SP1, you can now enable and configure a software downloadable update. The end user
can either download a newer version or skip and proceed with the current installation process. A new Installer
Updates option has been added to the Upgrades view where you can specify these downloadable update
settings.

Enable Downloadable Update Support

You can now enable updates for the end users to see the downloadable update support. The installation has the
ability to check for downloadable updates.

To enable updates, select the Enable Updates option on the Installer Updates option of the Upgrades view.

Specify Download URL

You can now enter the download URL in the Download URL field on the Enable Updates option on the Installer
Updates option of the Upgrades view.

The Download URL is a web hosted location where iaupdate.xml and downloadable updates are hosted.

Enable Force Install

You can now use this option for the end users to forcibly download and install the updates (if available).

Configure Prompt Message

You can now customize the message and provide a title for the message that is displayed during the installation
to prompt the end users.

Specify Prompt Message Title

You can now specify the title of the Upgrade Prompt message for the end users.

Specify Prompt Message

You can enter the customized message in the Message field on the Upgrade Prompt to the Installer Updates
option of the Upgrades view. You can either provide a new message or use default localized string.

Support for Java 11

InstallAnywhere 2018 SP1 now supports the latest version of Java, Version 11. Open JDK 11 VM packs that are
bundled for Windows, Linux and MAC target platforms.

Using InstallAnywhere 2018 SP1, you can create installers that support Java 11, including:
® Creating Java 11 VM packs
® Creating installers which uses bundled Java 11 VM pack

Creating installers that can detect a Java 11 on the host and run automatically
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Improved Designer Search & Expanded Search Functionality

Stronger searching finds what you need fast - search your entire project for text or variables and navigate
automatically to the referenced location.

Now, InstallAnywhere supports expand search functionality for String Value and variable. If the partial search is
unchecked, the string search will search for the whole text. If the partial search is checked, then the parts of
strings & variables will also be searched.

The “Variable Search” which is a new checkbox has been added in InstallAnywhere.

e |If the Variable Search check box is checked, it will enclose with a dollar sign symbol ($) before and after the
variable to search for a variable.

e If the Variable Search check box is unchecked, it will not be enclosed with a dollar sign symbol ($) before and
after the text to search for a string and variable.

® The results of the search shows in a tree structure with the total number of strings. The Items that are
associated with the string are listed below, and grouped by category:

® Pre-Install

® |[nstall

® Post-Install

® Pre-Uninstall
® Post-Uninstall

® The Search result node displayed navigates to the corresponding action which is then displayed in a tree
structure.

In InstallAnywhere 2018, you used to replace all instances of a variable with the replacement variable.

Now in InstallAnywhere 2018 SP1, you can replace the strings with all instances. Search for a string and select
‘Replace All'. Enter the string which you want to replace with.

Ability to Provide a Simple Way to get a Feature's Long Name from its Short Name

A new read only variable $CHOSEN_INSTALL_FEATURE_LIST_LONG$ is added under the InstallAnywhere Variables
list which contains the long names of the installed Features. This variable can be used to get the long name of the
feature from the feature short name.

Ability to Hold the Path for Global InstallAnywhere Registry Location

A new read only variable $IA_GLOBAL_REG_LOCATIONS$ is added under InstallAnywhere Variables list which holds
the path for global InstallAnywhere registry location. This variable can be used to determine where the global
registry is present on the target machine.

Allow Alignment of Input Fields for Get User Input Panel

The Selection box for the ‘Control Alignment’ has been added in Get User Input Panel Advanced-> Configure
Selection of Text Field. By default, the Alignment selection will be ‘Left’ and the alignment changes applies to Text
Fields.

There are two possible values for the text alignment controls that is ‘Left and ‘Right’.
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Ability to Support tar.gz and tar.z

The Expand Tar action now also supports expanding of tar.gz and tar.z files.You can use the Expand Archive (TAR)
action to expand a TAR, .gz, .Z archive file on the target system.

Ability to Read REG_MULTI_SZ Values from Get Windows Registry Entry Action

There is an ability to read multi string REG_MULTI_SZ values from the Windows Registry and store the value in an
InstallAnywhere Variable(s).

Option to Set Size field via InstallAnywhere Project for Add or Remove Programs
Applet on Windows

This new field 'Estimated size(in MB)' is added under Projects-> Platforms->Windows section for all project types.
By default 'Estimated size(in MB)' field value will be blank. You can enter an estimated size of any value > 0 (Zero)
and <= 4194303(4TB).

Note = Cannot enter floating/decimal value for an estimated size.

Ability to Set Installer Title Image on a Linux and MAC Machine for Windows Build
Target

The Installer Title image setting is now enabled for Linux and MAC platform so that it can be used to build
windows target from both Linux and Mac.

What’s New in InstallAnywhere 2018

28

For information about new features and enhancements added in InstallAnywhere 2018, refer to the following
sections:

® Perform Open Source Risk Assessment and Vulnerability Scan with FlexNet Code Aware

e All InstallAnywhere Features Now in a Single Edition

e Redesigned InstallAnywhere Advanced Designer User Interface

® Enhanced Upgrade Installers Now Accommodate Maintenance Mode and Instance Management

® Support for Java 9

® Ability to Customize the Windows File Properties of an Installer Executable File for a Windows Build Target
® Ability to Customize the Get Info Property Value for Copyright Field for an 0S X / macOS Build Target

® Ability to Add Checkbox to Install Complete Panel to Launch Target Application or README File

® Option to Disable Logging Upon User Cancellation During Pre-Install Sequence

® Execute Script/Batch File Action Run in Console Mode Now Writes Action Type and Identifier to Console
® In Console Mode, User Can Now Move Forward Without Scrolling Through the Entire License Agreement
® Ability to Set Compiler Flags, Such as SafeSEH, for Executables Installed on Windows

® ANT Version Associated with Execute ANT Script Action Updated to ANT 1.9.9
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® New Compare Versions Rule

® Expand/Collapse Buttons on Sequence Page Views

® Get Password Action Console Panel Now Available in Pre-Uninstall and Post-Uninstall Phases
® New User-Defined Range of Installer Exit Codes

® New Variable to Store Response File Location

® Launching Build from User Interface Now Leaves Current Project Unchanged

Perform Open Source Risk Assessment and Vulnerability Scan with FlexNet Code
Aware

There is an increasing need to understand the licensing obligations of all open source software components
being bundled with a software application. At the same time, users are getting increasingly worried about the
vulnerabilities that these open source components bring in. With InstallAnywhere’s new FlexNet Code Aware
scanning feature, users will get the insight into the licensing obligations and vulnerabilities associated with all
open source components.

InstallAnywhere now includes full integration with FlexNet Code Aware, an automated open source risk
assessment and package discovery solution that enables you to quickly scan your products for security and
intellectual property (IP) compliance risk.

® Supported File Types

® Running FlexNet Code Aware from Within InstallAnywhere
® Running FlexNet Code Aware as a Standalone Product

® Reading the FlexNet Code Aware Report

® More Information

Note = FlexNet Code Aware is automatically activated when you activate InstallAnywhere. However, the FlexNet
Code Aware license expires one year from the date that it is first launched.

H

Important = FlexNet Code Aware is not supported on 32-bit machines. A 64-bit operating system is required.

Supported File Types

FlexNet Code Aware supports analysis of the following files:
e Java Packages

® Node Packages

® Nuget Packages

® RPM Packages

® Ruby Packages

® EXE &DLL Files
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Security vulnerabilities are looked up against the National Vulnerability Database (NVD).

Running FlexNet Code Aware from Within InstallAnywhere

To run FlexNet Code Aware from within InstallAnywhere, click Run FlexNet Code Aware Analysis on the
InstallAnywhere Tools menu.

When FlexNet Code Aware completes the scan of your project, the Results Summary view opens, displaying the
number of files scanned, and the number of open-source packages and vulnerabilities found.

(ERA SOFTWARE®

FElexNe’r Code Aware

View Report

Click 'View Report’ to close Code Aware and open the report in a browser.

Files Packages Vulnerabilities

Files Scanned Packages Found Vulnerabilities Found

2,532 144 167

Figure 1-1: FlexNet Code Aware Results Summary

When you click the View Report button, a full report is displayed.

Running FlexNet Code Aware as a Standalone Product

Rather than scanning the files in the open InstallAnywhere project, you can also launch FlexNet Code Aware as a
standalone product and select a directory of files to scan.
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3 Flexiiet Code Aware 2017 R3 - X
FlexNet” Code Aware’
Welcome

FlexNet Code Aware is an : risk assessment and package discovery solution.
It scans all file 5 in the se n, and generates a with the follo g information:

+» Scanned Codebase Metrics
» Operational Risk Assessment

P itk yrigh

» Complete package inventory with associated licensing information and security vulnerabilities

Figure 1-2: FlexNet Code Aware Welcome Panel

Just click Browse, select the directory that you want to scan, and then analysis will begin.

Reading the FlexNet Code Aware Report

When you click View Report on the Results Summary screen, the full FlexNet Code Aware report opens, consisting
of an Initial Summary view and a Package Inventory view.

Initial Summary View

The Initial Summary view presents the user with a scan summary, and assessments of operational risk, security
vulnerability exposure, and license exposure.
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FLEXERA SOFTWARE®
u FleXNe" COde AWG re @ Getting startes @ Next steps

SCAN SUMMARY ()
Scan Target: C:\Users\bhull\Documents'\ePortal-2.0\ePortal-2.0
Scan Date:  04/26/2017 10:17
Scan Duration:  00:00.51
Number of Scanned Files: 2532

Size of Scanned Files: 105 84 MB 2 532
0SS Packages Discovered: 144 (view full package inventary) ?

| |

144 0f 170 (85%) of binary s were analyzed

] | B source 527 Fites - 33%)
[ sinaries (170 Fiies - 7%)

D Media (232 Files - 9%)

FOr a more comprenensive scan, contact us 1o learm more about FlexNet Code Insight @) D Others (1,303 Files - 51%)

144 of 2,532 (6%) of all scanned files were analyzed

OPERATIONAL RISK

[ Your codebase represents a Moderate level of Operational Risk.

Packages with Security Vulnerabiiities @ 17 out of 144 (12%)
I

Packages with Intellectual Property (1P} Issues @ 12 out of 144 (8%)
Packages with Copynght Statements @ 71 out of 144 (49%)

SECURITY VULNERABILITY EXPOSURE LICENSE EXPOSURE

| |
»

-4'
-|

144

. High (19 Vulnerabilities - 11%) . P1 - Viral /| Copyleft (8 Packages - 6%)
[ Medium (128 Vuinerabilites - 77%) ] P2- Commercial / Uncommen / Unknown (4 Packages - 3%)
|:| Low (19 Vulnerabilities - 11%) . P3 - Permissive / Public Domain (42 Packages - 29%)

l:l No License Found (90 Packages - 62%)

etk AN FLEXERA
Figure 1-3: FlexNet Code Aware Initial Summary View

The FlexNet Code Aware Initial Summary View displays the following information:

® Scan Summary—This section provides details regarding the codebase that was scanned, including a
breakdown of file types, percent of files analyzed, and number of findings.

® Operational Risk—This section provides a composite risk rating based on the combination of packages with
Intellectual Property (IP) issues and packages with Security Vulnerabilities.

® Security Vulnerability Exposure and License Exposure—These sections provide a breakdown of the types
and categories of identified issues.
Package Inventory View

The Package Inventory view, available by clicking View full package inventory in the Scan Summary section,
provides a complete list of discovered open source and third-party packages with associated licenses, security
vulnerabilities, dependencies, and detected copyright statements.
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FLEXERA SOFTWARE®

il Fle)(hlell.tD COde AWO re eGetting Started eNext Steps
N T S

Enter keyword.. [ @ High Severity (CVSS 7.0 - 10.0) [1 & P1-Viral / Copyleft
[1 @ Medium Severity (CVSS 4.0-6.9) [1 © P2 - Commercial / Uncommen / Unknown
B CYEIEVE0000009 [ O Low Severity (CVSS 0.0 - 3.9) [ @ P3- Permissive / Public Domain

Enter copyright holder [[] No License Found

Licenses Legend: @ P1-Viral / Copyleft (O P2 - Commercial { Uncommon / Unknown @ P3 - Permissive | Public Domain

Browsing 1-10 of 144 Packag bilities Legend: @@ High Severity (CVSS 7.0 - 10.0) (@ Medium Severity (CVSS 4.0 - 6.9) (0 Low Severity (CVSS 0.0 - 3.9)
mysql_connector_c 5.1.7 No License Found Mysql ' 94 | Bs gn 01s None Found
struis 1.2.7 . Apache-2.0 Apache . 7 | B2 [ K Jo None Found
spring_framework 3.0.5 RELEASE . Apache-2.0 Pivolal_soflware . 6 | 81 @5 Qo None Found
spring_framework 3.0.5.RELEASE . Apache-2.0 Springsource . 3 | [ 85 Qo None Found
spring_framework 3.0.5.RELEASE ' Apache-2.0 Pivotal_software ' [ | [ @5 do None Found
spring_framework 3.0.5.RELEASE ' Apache-2.0 Pivotal_software ' [ | [ [ K do None Found
spring_framework 3.0.5.RELEASE ' Apache-2.0 Pivotal_software ' [ | [ [ K do None Found
spring_framework 3.0.5.RELEASE ' Apache-2.0 Pivotal_software ' [ | [ N @5 Jo None Found
spring_framework 3.0.5.RELEASE ' Apache-2.0 Pivotal_software ' 8 | [ @5 do None Found
spring_framework 3.0.5.RELEASE . Apache-2.0 Springsource . [ | [ Bs Oo MNone Found

10 v 2808 BO0
Figure 1-4: FlexNet Code Aware Package Inventory View

The Package Inventory view provides filters that you can use to execute targeted queries to refine the list to
various package types of interest.

To view additional package details, click a vulnerability count listed in the Vulnerabilities column of the package
you want to review:

Vulnerabilities

"r ||2 @s Qo
's | 8" @5 0o

Figure 1-5: Vulnerabilities Column

The Vulnerabilities Detail page opens (covering a portion of the Package Inventory view), and displays detailed
information on the selected package.
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struts 1.2.7 [ x]

Name siruts 1.2.7
Version 127
License ' Apache-2.0

Vulnerabilities [ 7 | @2 @5 Do

Description The core of the Struts framework is a flexible control layer
based on standard technologies like Java Servlets, JavaBeans,
ResourceBundles, and Extensible Markup Language (XML), as
well as various Jakarta Commons packages. Struts encourages
application architectures based on the Model 2 approach, a
wvariation of the classic Model-View-Controller (MVC) design
paradigm. Struts provides its own Controller component and
integrates with other technologies to provide the Model and the
View. For the Model, Struts can interact with any standard data
access technology, including Enterprise Java Beans, JDBC,
and Object Relational Bridge. For the View, Struts works well
with JavaServer Pages, including JSTL and JSF, as well as
Velocity Templates, XSLT, and other presentation systems.
The Struts framework provides the invisible underpinnings
every professional web application needs to survive. Struts
helps you create an extensible development environment for
your application, based on published standards and proven
design patterns.

Path C:\Users\bhullDocumentis\ePortal-2.0\ePortal-2.0
‘extras\struts-1.2. P\contrib\struts-eNib\struts jar
C\Users\bhullDocuments\ePortal-2 0\ePortal-2.0
‘extras\struts-1.2 T\lib\struts jar

Evidence pom.xml
Type
Maven GAV  struts:struts:1.2.7
Vendor Apache

Copyrights None Found

CVE ID: CVE-2006-1547
severity: [ High
CVSS Score: 7.8

Figure 1-6: Vulnerabilities Detail

More Information

For detailed information on using FlexNet Code Aware, see Using FlexNet Code Aware to Perform Open Source
Risk Assessment in the InstallAnywhere Help Library.

All InstallAnywhere Features Now in a Single Edition

Previous versions of InstallAnywhere were available in two different editions, Professional and Premier, with
additional features included in add-on Virtualization and Cloud packs. Starting with InstallAnywhere 2018, all
features are included in a single edition.

After upgrading to InstallAnywhere 2018, you will have access to all features, including these features that were
previously only available in Premier Edition and with the add-on packs:

® Extensive run-time language support—InstallAnywhere includes default run-time strings in 32 supported
languages, and gives you the ability to include custom localized splash screens in your installations.

e Built-in support for creating upgrades—You can create upgrades that uninstall earlier versions of the
product if present before installing the new version.

1A-2021-UG00 InstallAnywhere 2021 User Guide



Chapter 1 InstallAnywhere 2021 SP1 Help Library
What Was New in Earlier Versions of InstallAnywhere

® Instance management support—You can create installers that let end users install multiple instances of a
product on the same machine.

® Predefined and custom source path variables—You can use predefined source path variables in your
installer, such as $IA_HOME$, $IA_PROJECT_DIR$, and $USER_HOME$. You can also use custom source
path variables.

e Build time variables—You can configure your project to use build-time variables, variables that have their
values set at build time.

e Flexible build configuration management—You can define tags to bundle related sets of actions, panels,
features, and components, and assign the tags to the appropriate items in your project. Then you can
associate the tags with specific build configurations to include or exclude items from builds.

® Flexible build target management—You can create different build targets for each platform that your product
supports.

® Ability to add custom GUI panels—You can design your own custom panels that guide end users through the
selection or completion of various Ul elements such as text boxes, check boxes, and lists.

® Merge module support—You can include merge modules in your installer project.

® Project automation APIs—InstallAnywhere includes project automation APIs that let you design, modify,
build, and test an installation from an InstallAnywhere project via Java code.

® Docker support—You can use InstallAnywhere to configure and build Docker images, and deploy Web
applications to the cloud as Docker images that are run as Docker containers.

e Virtual appliance support—You can build enterprise-ready and cloud-ready multi-tier virtual appliances for
VMWare ESX based on your existing InstallAnywhere projects.

® Ability to share components with other products—You can optionally identify a component in your project as
shared. At run time, if this type of component is not already present on a target system, the installer adds it.
If it is already present, the installer registers it as shared.

All existing customers will be upgraded to the full-featured, single edition.

Redesigned InstallAnywhere Advanced Designer User Interface

The user interface of InstallAnywhere 2018'’s Advanced Designer has been redesigned and updated to provide a
cleaner, more modern look, with a new black / gray / blue color scheme.

A user-friendly tabbed interface improves the ease of switching between views. Buttons on the Sequence tab
have been repositioned to a more logical location above the Action lists.
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InstallAnywhere 2018 - My_Product_1 (My_Product_l.iap_xmi) - o ®

File Edit Tools Help BuyNow

InstallAnywhere

£ Project [ Installer Ul £ Organization i= Sequence «® Build

3 Ppre-install
SetClasspath | AddFiles | AddLauncher || Add Action Remove Alv|al»

Install s
* Assign Actions to Product Features Product Features - [[LENTILGT] Help.

& Post-Install © [ User Install Folder (SUSER_INSTALL_DIRS)

[& _SPRODUCT_NAMES_installation

A pre-Uninstall
= [ Shortcuts' Destination Folder (SUSER_SHORTCUTSS)

4 Uninstall B Change SPRODUCT_NAMWES Installation

B post-Uninstall

Properties Customizer o

Magic Folder: User Install Folder ($USER_INSTALL_DIRS)

Properties Magic folders represent special locations on the end user's system
Rules [Jin ciasspath

[ override default UNIX / Mac 05 X permissions

Rollback

Figure 1-7: Redesigned Advanced Designer User Interface of InstallAnywhere

The Create/Open Project dialog box that opens when you launch InstallAnywhere has also been redesigned to be
more user friendly.

InstallAnywhere”
PAORS

GO

Create new project Open existing project

Figure 1-8: Redesigned Create/Open Project Dialog Box
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When you click Create new project on the Create/Open Project dialog box, the redesigned Create New Project
dialog box opens, prompting you to select the desired template to use, enter a name for the project, and select a
location for the project.

S o]

Basic Project Typical Quick Install
Template Project Template Template

< C]

Sample Dependency Console Project
Template Template

Other Template...

R EI o My_Product_2.iap_xml

Project Path: C\Install&nywhere 2018 Projects j

Create project file in 'Project Name' subfolder

Cancel

Figure 1-9: Redesigned Create a New Project Dialog Box

Enhanced Upgrade Installers Now Accommodate Maintenance Mode and Instance
Management

In InstallAnywhere 2018, the behavior of upgrade installers has been enhanced to accommodate maintenance
mode and instance management.

Previously, upgrade installers did not support maintenance mode or instance management. Upgrade installers
could only upgrade an earlier version of an application (by uninstalling the previous version and installing the new
version), or, if an earlier version does not exist, just install the new version.

In InstallAnywhere 2018, you can use an upgrade installer to add or remove features of a previously installed
version as well as repair broken installations. You can also use an upgrade installer to specify whether multiple
instances of a product can be installed on the same machine. At runtime, the user can choose which instance of
the product to upgrade or perform maintenance on.

Note = This feature is not supported when performing a silent upgrade.

Support for Java 9

InstallAnywhere 2018 now supports the latest version of Java, Version 9. Using InstallAnywhere 2018, you can
create installers that support Java 9, including:

® Creating Java 9 VM packs

® Creating installers that bundle a Java 9 VM pack
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® Creating installers that can detect a Java 9 VM on the host and run automatically

Ability to Customize the Windows File Properties of an Installer Executable File for a
Windows Build Target

In previous releases, when you viewed the Details tab of the Windows Properties dialog box for an
InstallAnywhere installer .exe file, information specific to the version of InstallAnywhere used to create the
installer was displayed instead of information specific to the product being installed:

General
Security

Global Cortact 8.5 Properties

Compatibility
Details

Digital Signatures
Previous Versions

Property
Description
File description

Type

File version
Product name
Product version

49 3 3

Copyright

Size
Date modiied
Language

Walue

Install Anywhere Self-Extractor
Application

19000

Global Contact 8.5

19000

2018 Flexera Software LLC
452 MB

2/25/2018 7:.57 AM

English (United States)

Original filename  globalcon85.exe

Remove Properties and Personal Information

Cancel

s

Apply

Figure 1-10: Details Tab of Windows Properties Dialog Box

The following hard-coded values were displayed for all Windows .exe installers created using InstallAnywhere:

® File description—Displayed InstallAnywhere Self-Extractor.

® File version—Displayed the version of InstallAnywhere that was used to create the installer.

® Product version—Displayed the version of InstallAnywhere that was used to create the installer.

® Copyright—Displayed InstallAnywhere’s copyright information.

For Windows installer .exe files created using InstallAnywhere 2018, the project-specific values entered on the
on the Project > General Settings page of the InstallAnywhere project file are now displayed on the Details tab of
the Windows Properties dialog box, instead of the previously hard-coded values.
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Ability to Customize the Get Info Property Value for Copyright Field for an 0S X /
macO0S Build Target

In previous releases, when you viewed the Copyright field on the Get Info dialog box for a Mac 0S X build target
for an installer targeting a 0S X / macOS operating system, the copyright information specific to the version of
InstallAnywhere used to create the installer was displayed instead of information specific to the product being
installed:

In InstallAnywhere 2018, you can now customize the Get Info property value for the Copyright field for a Mac 0S X
build target.

The Copyright and Version fields can be edited on the InstallAnywhere Project > General Settings view under
Product Information. The values entered here will be displayed on the dialog box that opens in 0S X / macOS
operating systems when you select the Get Info option.

Ability to Add Checkbox to Install Complete Panel to Launch Target Application or
README File

In InstallAnywhere 2018, a new option has been added to configure the Install Complete panel to display a
checkbox to prompt the user to launch a README file and/or launch a target application. The application could be
either the main target application of the product that was just installed, or a utility installed alongside the
product.

Option to Disable Logging Upon User Cancellation During Pre-Install Sequence

A new option has been added to enable you to disable logging if the user cancels an installation during the Pre-
Install sequence.

To disable logging, open the Project > General Settings view of the Advanced Designer, scroll down to the Log
Settings group, and set the Skip Logging in Pre-Install option to Yes.

Execute Script/Batch File Action Run in Console Mode Now Writes Action Type and
Identifier to Console

When run in console mode, an InstallAnywhere installer displays a Please Wait message during installation for
each Execute Script/Batch File action and Execute Command action included in the Install Sequence or Post-
Install Sequence.

In InstallAnywhere 2018, an installer running in console mode now identifies each action that displays a Please
Wait message by also displaying the type of action (Execute Script/Batch File or Execute Command) and an
action title/name.

In Console Mode, User Can Now Move Forward Without Scrolling Through the Entire
License Agreement

In InstallAnywhere 2018, a new option has been added to enable users using a console mode installer to proceed
to the next step without scrolling through the entire license agreement.

When you add a License Agreement console screen to an installer on the Sequence > Pre-Install page, you can
now select the Do not force user to scroll through license agreement option.
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Properties Customizer "
Console: License Agreement
Properties Title: License Agreement
sl Prompt: Installation and Use of SPRODUCT_NAMES Requires Acceptance of the Following License Agreement:
ules
License Agreement Text Source File:
Tags (®) Installed File: SUSER_HOMES\Desktop\license.htm. bt Choose File

o Existing File: <MNo license agreement text file selected>

Mote: this console supports the display of both HTML and plain text files

’ Do not force user to scroll through license agreement

Figure 1-11: Properties Tab of Console: License Agreement Console Screen

When this option is selected, users using a console mode installer will be able to accept or reject the license
agreement without scrolling through all of the text of the license agreement. The following text will be displayed:

PRESS ANY KEY TO CONTINUE TO READ LICENSE AGREEMENT OR PRESS '@' to ADVANCE TO END

Note = To control whether a user using a panel mode installer can proceed to the next step without scrolling
through the entire license agreement, use the Force user to scroll through license agreement option on the
Properties tab of the Panel: License Agreement > Properties tab.

Ability to Set Compiler Flags, Such as SafeSEH, for Executables Installed on
Windows

In previous releases, executables installed on Windows did not meet security requirements because compiler
flags, such as SafeSEH, were not set. In InstallAnywhere 2018, compiler flags are now set properly for
executables installed on Windows. These executables now pass the SafeSEH check.

Support has been added to LaunchAnywhere (32-bit and 64-bit) and SelfExtractor (32-bit and 64-bit) projects for
the following flags:

® /SAFESEH—This is applicable only for 32-bit target and not applicable for 64-bit targets. Therefore, for all
64-bit build configurations, we have set this flag to NO.

e /HIGHENTROPYVA—This is applicable only for 64-bit executable images. This is not applicable for 32-bit
executable images.

ANT Version Associated with Execute ANT Script Action Updated to ANT 1.9.9

In InstallAnywhere 2018, the ANT version associated with the Execute ANT Script action has been updated to ANT
1.9.9 for both InstallAnywhere development and InstallAnywhere runtime.

ANT 1.9.9 supports Java 1.5 and above. For more information, see:

http://ant.apache.org/manual/install.html
https://ant.apache.org/fag.html

New Compare Versions Rule

InstallAnywhere 2018 now includes a new Compare Versions rule that enables you to specifically compare two
version numbers during an installation. This new rule is displayed on the Choose a Rule/Expression dialog box
that opens when you click Add Rule on the Organization or Sequence page.
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™ Choosea Rule/Expression

Rules  Expressions

g Check File/Folder Attributes

ﬂ Check Platform

ﬂ Check System Architecture

g Check User-Chosen Language

ﬁ Compare InstallAnywhere Variables

ﬁ Compare InstallAnywhere Variables Numerically

ﬂ Evaluate Custom Rule
ey

L

[cose s |

Figure 1-12: New Compare Versions Rule

When you add a Compare Versions rule, you are prompted to enter two operands and an operator in the Compare

Versions Properties Customizer. Both operands may be expressed as either an InstallAnywhere variable being
resolved (such as $VARIABLE1$) or as a literal version number string (such as 1.0.0.0).

Properties Customizer

Rule Expression
Properties cvsio

Rule

Compare Versions

Compare Versions
Perform Only If:
Operand 1:

4.3.00

1D

Operand 2:
greater than or equal to [ »= Jﬂ 35.6.0

Note: Operand may be expressed as either a variable (ex: SMY_VARIABLES) or as a literal {ex: 1.0.0.0)

®
n

.'.‘anj Rule

Remove Rule

Validate Rule
Clear Rule

Figure 1-13: Compare Versions Rule Properties Customizer

Expand/Collapse Buttons on Sequence Page Views

In InstallAnywhere 2018, an Expand and a Collapse button have been added to views on the Sequence page to
quickly collapse or expand the items in the Action List tree.
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InstallAnywhere 2018 - My_Product_2 (My_Product_2.iap_xml}

File Edit Tools Help BuyNow

InstallAnywhere

£ Project [ Installer UI i= Sequence 4 Build

2 Organization

Pre-install

X Install .
Pre-Install Action List

Post-Install =1 (@) Action Group: 101 A

[ panet: Intreduction: Introduction
A Pre-Uninstall
[[] Panet: choose Install Folder: thoose Install Folder

Uninstall [[] Panst: choose Alias, Link, Shortcut Folder: Choose Shorteut Folder

D Panel: Pre-Install Summary: Pre-Installation Summary

Post-Uninstall

- £ @) Action Group: 102
[ panet: Intreduction: Introduction
[[] Panet: choose Install Folder: thoose Install Folder

D Panel: Choose Alias, Link, Shortcut Folder: Choose Shortcut Folder v

Figure 1-14: New Expand and Collapse Buttons on the Sequence Page

When you click the Collapse button, the items in the tree are collapsed into their primary item:

NEARIC

Pre-Install Action List

@) Adtion Group: 101
(@) Action Group: 102

Figure 1-15: Collapsed Items in the Tree

Get Password Action Console Panel Now Available in Pre-Uninstall and Post-
Uninstall Phases

Previously, you could not add a Console: Get Password action during Pre-Uninstall and Post-Uninstall tasks for
console mode installers.

In InstallAnywhere 2018, you can now add a Console: Get Password action during Pre-Uninstall and Post-
Uninstall tasks for console mode installers. You can also add a Console: Get Password action during Pre-Uninstall
and Post-Uninstall tasks after adding a merge module project, which previously was not possible.

New User-Defined Range of Installer Exit Codes

InstallAnywhere 2018 now includes a range of user-defined installer exit codes. These can be used to act upon
scripts that are included in your installers. The following 20 exit codes were added for customer use:

Table 1-3 =
Linux Exit Codes 43 to 62
Other Exit Codes 10795 to 10814

1A-2021-UG00 InstallAnywhere 2021 User Guide



Chapter 1 InstallAnywhere 2021 SP1 Help Library
What Was New in Earlier Versions of InstallAnywhere

New Variable to Store Response File Location

A new InstallAnywhere variable named $IA_RESPONSEFILE_PATH$ has been added to store the complete location of
a response file being used by the installer.

Launching Build from User Interface Now Leaves Current Project Unchanged

In previous releases, when you initiated a build from the InstallAnywhere user interface, InstallAnywhere would
first save the current project before performing the build. However, if you initiated a build from the command line,
a new build copy of the current project would be made (projectBuild.iap_xml) before the build was performed,
leaving the original project unchanged.

In InstallAnywhere 2018, the behavior when you initiate a build from the user interface matches the behavior
when launching a build from the command line. In both cases, a build copy of the project file is made prior to the
build, leaving the original project file unchanged.

What’s New in InstallAnywhere 2017 SP1

InstallAnywhere 2021 SP1
Refer to the following sections for new features and changes in InstallAnywhere 2017 SP1:
® Integration with FlexNet Code Aware

® Enhancement to Existing GUI Automation Fixture

Integration with FlexNet Code Aware

Note = For complete information about FlexNet Code Aware, refer to the FlexNet Code Aware user documentation.

InstallAnywhere now includes integration with FlexNet Code Aware, an automated open source risk assessment
and package discovery solution that enables you to quickly scan your products for security and intellectual
property (IP) compliance risk.

The current release of FlexNet Code Aware supports analysis of the following files:
e Java Packages

® Node Packages

® Nuget Packages

® RPM Packages

® Ruby Packages

® EXE & DLL Files

Security vulnerabilities are looked up against the National Vulnerability Database (NVD).

Running FlexNet Code Aware

FlexNet Code requires a separate license from InstallAnywhere. There is also trial/evaluation version. For more
information, refer to the FlexNet Code Aware product page of the Revenera website.
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To run FlexNet Code Aware from within InstallAnywhere, click Run FlexNet Code Aware Analysis from the
InstallAnywhere Tools menu. This menu option is disabled out if you are not currently in an open InstallAnywhere
project.

When FlexNet Code Aware completes the scan of your project, a summary displays showing the number of files
scanned, and the number of open-source packages and vulnerabilities found. A View report button is provided if
you have a fully licensed version of FlexNet Code Aware. For more information about the details provided in this
report, refer to Reading the FlexNet Code Aware Report.

5

el B s Aware

View Report

Click 'View Report' to close Code Aware and open the report in a browser.

Files Packages Vulnerabilities

¥ A

Files Scanned Packages Found Vulnerabilities Found

2,532 144 167

Reading the FlexNet Code Aware Report

Note = The FlexNet Code Aware Report is not available in trial/evaluation mode. A fully licensed version of FlexNet
Code Aware is required.

To view the FlexNet Code Aware Report, click View report on the summary dialog that appears after FlexNet Code
Aware has scanned your project.

The FlexNet Code Aware report consists of several sections:

® The initial Summary View presents the user with a Scan Summary, Operational Risk assessment, Security
Vulnerability Exposure, and License Exposure.

® The Scan Summary section provides details regarding the codebase that was scanned, including a
breakdown of file types, percent of files analyzed, and number of findings.

e The Operational Risk section provides a composite risk rating based on the combination of packages
with Intellectual Property (IP) issues and packages with Security Vulnerabilities.

e The Security Vulnerability Exposure and License Exposure sections provide a breakdown of the types
and categories of identified issues.
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® The Package Inventory View, available by clicking view full package inventory in the Secan Summary section,
provides a complete list of discovered open source and third-party packages with associated licenses,
security vulnerabilities, dependencies, and detected copyright statements.

The Package Inventory View provides filters that you can use to execute targeted queries to refine the list to
various package types of interest.

The following figures show the initial Summary View of a sample FlexNet Code Aware Report.

FLEXERA SOFTWARE®
E FlexNet' Code Aware

@ Geting staries @ Next steps

SCAN SUMMARY o

Scan Target: C:\Users\bhulDocuments'ePortal-2 0\ePortal-2.0
Scan Date: 04/26/2017 10:17
Scan Duration.  00.00.51
Mumber of Scanned Files. 2.532
Size of Scanned Files: 105 84 MB 2 532
0SS Packages Discovered: 144 {view full package inventary) ’

| |

144 of 170 (85%) of binary les were analyzed

) ‘ B source 527 Files - 33%)
[T sinaries (170 Fites - 7%)

D Media (232 Flles - 9%)

For a more comprehensive scan, contact us 1o learn more about FlexNet Code Insight o D Others (1,303 Files - 51%)

144 of 2,532 (6%) of all scanned files were analyzed

OPERATIONAL RISK

Your codebase represents a Moderate level of Operational Risk.

Packages with Security Vulnerabilities @ 17 out of 144 (12%)
I

Packages with Intellectual Property (IP) Issues @ 12 out of 144 (8%)
I

Packages with Copyright Statements @) 71 out of 144 (49%)

SECURITY VULNERABILITY EXPOSURE LICENSE EXPOSURE

» J

167

144

. High (19 Vulnerabilities - 11%)
. Medium {129 Vulnerabilities - 77%)
I:‘ Low (19 Vulnerabilities - 11%)

. P1 - Viral / Copyleft (8 Packages - 6%)
D P2 - Commercial / Uncommen / Unknown (4 Packages - 3%)
[l F3- Pemissive / Public Domain (42 Packages - 29%)

D No License Found (90 Packages - 62%)

S s FLEXERA
Figure 1-16: FlexNet Code Aware Initial Summary View

The following figures show the Package Inventory View of a sample FlexNet Code Aware Report.

InstallAnywhere 2021 User Guide 1A-2021-UG00 45



Chapter 1 InstallAnywhere 2021 SP1 Help Library
What Was New in Earlier Versions of InstallAnywhere

FLEXERA SOFTWARE®

FIeXNeF COde AWC' re eGetting Started 9 Next Steps
e S N

Enter keyword.. [] @ High Severity (CV3S 7.0-10.0) ] @ P1-Viral/ Copyleft
[0 @ Medium Severity (CVSS 4.0 -6.9) [ @ P2 - Ccommercial / Uncommon / Unknown
Enter CVE (CVE-XOCK-XXHX) . _ ) )
: O O Low Severity (CVSS 0.0-3.9) [0 @ P3 - Permissive / Public Domain

ht holder [] No License Found

Licenses Legend: @ P1-Viral/ Copyleft () P2 - Commercial / Uncommon / Unknown @ P3 - Permissive / Public Domain

Browsing 1-10 of 144 Packages Vulnerabilities Legend: @ High Severity (CVSS 7.0 - 10.0) (@ Medium Severity (CVSS 4.0 - 6.9) () Low Severity (CVSS 0.0 - 3.9)
mysql_connector_c 5.1.7 No License Found Mysql . 94 | an 018 None Found
struts 1.2.7 . Apache-2.0 Apache . 7: | 82 0+ 0o None Found
spring_framework 3.0.5.RELEASE . Apache-2.0 Pivotal_software . [ | [ [ go None Found
spring_framework 3.0.5.RELEASE . Apache-2.0 Springsource . 6 | [ I @s Jo None Found
spring_framework 3.0.5.RELEASE . Apache-2.0 Pivotal_software . [ | [ Qs Jo None Found
spring_framework 3.0.5.RELEASE ' Apache-2.0 Pivotal_software ' 6 | [ I @s Oo None Found
spring_framework 3.0.5.RELEASE . Apache-2.0 Pivotal_software . [ | [ [ 0o None Found
spring_framework 30.5RELEASE ] Apache-2.0 Pivotal_software [ 6 | @1 @5 Qo None Found
spring_framework 3.0.5.RELEASE . Apache-2.0 Pivotal_software . [ | [ 0s Jo None Found
spring_framework 3.0.5.RELEASE . Apache-2.0 Springsource . 6 | [ @s Oo None Found

TS pE0E GO
Figure 1-17: FlexNet Code Aware Package Inventory View

Viewing Package Details

Click a vulnerability count listed in the Vulnerabilities column of the Package Inventory report page for each
package you want to review:

Vulnerabilities

K | @2 @5 Q0o
.a ||1 @5 (o

The Vulnerabilities detail page appears, covering a portion of the Package Inventory report:
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struts 1.2.7 (]

Name
Version

License
Vulnerabilities

Description

Path

Evidence
Type
Maven GAV
Vendor

Copyrights

struts 1.2.7
127
. Apache-2.0

| K | @2 @5 Qo

The core of the Struts framework is a flexible control layer
based on standard technologies like Java Serviets, JavaBeans,
ResourceBundles, and Extensible Markup Language (XML), as
well as various Jakarta Commons packages. Struts encourages
application architectures based on the Model 2 approach, a
variation of the classic Model-View-Controller (MVC) design
paradigm. Struts provides its own Controller component and
integrates with other technologies to provide the Model and the
View. For the Model, Struts can interact with any standard data
access technology, including Enterprise Java Beans, JDBC,
and Object Relational Bridge. For the View, Struts works well
with JavaServer Pages, including JSTL and JSF, as well as
Velocity Templates, XSLT, and other presentation systems.
The Struts framework provides the invisible underpinnings
every professional web application needs to survive. Struts
helps you create an extensible development environment for
your application, based on published standards and proven
design patterns.

ChUsers\bhullDocuments'ePortal-2. 0\ePortal-2.0
\extras\struts-1.2. Ticontrib\struts-eNib\struts. jar
C\Users\bhullDocuments\ePortal-2. 0\ePortal-2.0
\extras\struts-1.2. 7\lib\struts_jar

pom.xm

struts:struts: 1.2.7
Apache

None Found

Security Vulnerabilities (v)

CVE ID; CVE-2006-1547
Severity: . High

CVSS Score:

7.8

Enhancement to Existing GUI Automation Fixture
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InstallAnywhere now has improved GUI Automation Fixture by adding new APIs for launching binaries; that is, you
can now launch Windows/Linux built-in installers in addition to the pure Java installer. The new APIs have ability
to interact with various Ul components and get Ul attributes of the components like labels, text fields,

checkboxes, radio buttons, combo boxes, list boxes and buttons.

Parameters that the APIs need can be obtained as an optional tool tip by running the installer with a special

command line.

install.exe -Diashowtooltip=true
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For complete information about each of the APIs, refer to the docs available at IA_HOME/gui-test-auto/javadocs.
For a sample GUI Automation class, refer to your InstallAnywhere build directory at IA_HOME/gui-test-auto/
example/source/com/installanywhere/ia/automation/gui/samples/basic/BasicProjectAutomation.java.

Supporting platforms: Windows and Linux.

What’s New in InstallAnywhere 2017

InstallAnywhere 2021 SP1

InstallAnywhere 2017 includes the following new features:

® New Rules Manager Allows Creation of Complex Rule Expressions at the Project Level
® (Customizable Advanced Runtime Ul Themes

® Ability to Install RPMs and DEBs from Install Linux Package Action

® Support for the Latest Platforms

® Enhancements

New Rules Manager Allows Creation of Complex Rule Expressions at the Project
Level

InstallAnywhere now includes a rule expression manager which allows installer authors to:
® Create complex rule expressions at the project level

® Combine multiple rules and save them to a single rule expression

® Reuse arule or a set of rules across the project

® Associate a rule expression to a file extension, including the option to automatically associate the rule
expression to a file whenever a file containing that file extension is added to the project

® Remove associated rules from custom file extensions

See the following help topics in the InstallAnywhere Help library for procedures about various functionality that
you can do with project level rule expressions:

® Configuring and Saving a New Rule Expression
® Associating a Rule Expression to a File Extension
® Loading a Rule Expression

® Deleting a Saved Rule Expression

Customizable Advanced Runtime Ul Themes

InstallAnywhere has improved the runtime user experience of the installer by adding customizable advanced
runtime Ul themes. A theme is a set of runtime Ul settings that are used to customize the installer panels and
frames. For example, you can specify fonts, font attributes, and even import your own fonts. You can customize
the colors of windows and buttons, choose to use frameless windows, display your company’s own logo in the
installer steps panels, and many other settings.
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For complete information about each of the advanced runtime Ul theme settings available and for information
about how to customize advanced runtime Ul themes, see the Ul Panel Settings Area topic.

Ability to Install RPMs and DEBs from Install Linux Package Action
B
Edition = These features are available in the following editions:

® InstallAnywhere Premier Edition with Virtualization and Cloud

® InstallAnywhere Premier Edition

In InstallAnywhere 2017, the Install Linux RPM install action has been updated to Install Linux Package and now
allows you to install and uninstall Linux RPM Package Manager (.rpm) files, Debian (.deb) packages, or files from
a default or a custom repository. The package files can either be bundled with the installer or can be pre-existing
on the system.

If you choose to install from a repository, there are two options:
® |Install from Repository—Install from the default distribution repository on the machine you are targeting

e Install from Repository / Custom Repository—Install from a specified location of a custom repository. When
you click the Custom Repository check box, the Choose Repository button is enabled, allowing you to search
for the custom repository location, choosing either a *.list file for Debian file distributions or *.repo for Linux.

If the RPM or DEB is relocatable, and the Relocatable check box is selected in the action customizer, the file is
installed to its location in the file tree.

Additionally, the RPM or DEB can be set to Ignore Dependencies (similar to the --nodeps option for the command-
line RPM tool) and to Force Installation (--force).

You can also choose Do Not Uninstall. For custom repositories, the only check box that is available is to Do Not
Uninstall.

The Install Linux Package action allows you to add only one package at a time. If you want to add additional
packages, click Add Action again.

For complete information about install actions, refer to the Install Actions topic.

Support for the Latest Platforms

InstallAnywhere now supports the following platforms for running the installer run-time environment, as well as
for the InstallAnywhere authoring environment:

® Windows 10 Anniversary Update (x86 and x64)
® Windows 2016 Server (x64)

® macOS Sierra (10.12)

® Red Hat Enterprise Linux 7.2 (x64)

® (OpenSUSE Linux 13.2 (x64)

® SUSE Linux Enterprise 12 (SP1, x64)

® Fedora 24 (desktop editions; x64)

InstallAnywhere now supports the following platforms for running the installer run-time environment:
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® (Cent0S 7 (x86, x64)
® (Cent0S 6.8 (x86, x64)
® Red Hat Enterprise Linux 7.2 for PowerPC (little endian)

® Ubuntu 16.04 LTS (x64)

Enhancements

This section lists enhancements that were included in InstallAnywhere 2017:

® New Command-Line Build-Related Argument to Generate Encrypted Variable Value
® New Require Root Setting Available Under Project Page in the Platforms View

® Modify Text File Action Enhancement

® Support for Croatian Local Added

New Command-Line Build-Related Argument to Generate Encrypted Variable Value

When building using the command line, you can use a new build-related argument to allow you to generate an
encrypted hexadecimal value that can be directly copied and pasted into a response file as an encrypted variable
value.

build -encrypt <product-code> <text-to-encrypt>

The resulting encrypted hexadecimal value can then be used later. For example, you could update the parent
response file with an encrypted value generated from a password without needing to first run the entire
installation to only generate this value.

This enhancement resolves issue 10J-1758930.

New Require Root Setting Available Under Project Page in the Platforms View

The following new settings are available in the Unix area of the Project Page under the Platforms view.

Table 1-4 = UNIX Settings

Setting Description

Require Root Specify whether the installer requires root account permissions. A root
account is the user name or account that by default has access to all
commands and files on a Linux or other Unix-like operating system. It is
also referred to as the root account, root user, or the superuser. If you
select Yes in this setting, the Error Message setting under Require Root
is enabled.

Error Message Specify an error message to appear if the installer is run with a non-root
account. This field is enabled when Yes is selected from the Require
Root drop-down list.
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Modify Text File Action Enhancement

The Modify Text File actions have been enhanced to allow you specify both the source file that is being opened
and read as well as the destination file that is being saved after it has been modified. To account for this change,
the previous File Encoding field has been replaced with the following two fields:

® Source File Encoding
® Destination File Encoding

In previous versions of InstallAnywhere, there were instances where leaving the File Encoding field blank resulted
in a loss of characters when saving the destination file as a result of Java not being able to easily detect what
kind of encoding the file was actually using. Therefore, with this enhancement, you can now explicitly specify the
source file and destination file encoding to ensure no loss of characters are experienced in the process. Now, the
encoding that is applied is dependent solely upon the destination file encoding provided irrespective of the
source file encoding. The following table provides example of the file encoding that is applied in cases where the
destination file coding is left blank, is invalid, or is unsupported.

Table 1-5 = File Encoding

Source File Encoding Destination File Encoding Encoding Applied
empty empty UTF-8

invalid (eg. Hello) empty UTF-8
unsupported (cp1047) empty UTF-8

empty invalid Platform default
empty unsupported Platform default

This enhancements applies to the following actions:
® Modify Text File - In Archive Action
e Modify Text File - Multiple Files Action

® Modify Text File - Single File Action

Support for Croatian Local Added

B

Edition = The Premier edition of InstallAnywhere includes default run-time strings in 31 supported languages.
TheProfessional edition includes default run-time strings in 9 languages.

InstallAnywhere has added support the Croatian locale. You can now specify Croatian as a locale you want your
installation to support. For information about specifying a locale to your installer, refer to the Generating
Multilanguage Installers topic.

See Also
Upgrading from Earlier InstallAnywhere Versions
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What’s New in InstallAnywhere 2015 SP1

InstallAnywhere 2021 SP1

Expanded Platform Support

InstallAnywhere now supports the following platform for the installer run-time environment, as well as for the
InstallAnywhere authoring environment:

® (S XEI Capitan (10.11) with Oracle Java 7 or 8

What’s New in InstallAnywhere 2015

52

InstallAnywhere 2021 SP1

New Features

InstallAnywhere includes the following new features.

Ability to Build Docker Images from InstallAnywhere Projects

InstallAnywhere Premier Edition with Virtualization and Cloud enables you use your existing InstallAnywhere
projects to configure and build Docker images along with your traditional multiplatform installers. You can use
the Docker support to prepare your on-premises Web applications for deployment to the cloud and to data
centers.

Docker is a platform that enables developers and system administrators to build, distribute, and run applications
on physical machines, data center virtual machines, or the cloud; it enables you to separate your applications
from your infrastructure. A Docker image is a read-only template that InstallAnywhere can build from your project.
A Docker container is launched from a Docker image. A Docker container consists of a complete file system that
includes everything that is needed to run—code, system tools, system libraries, and more; it is the run component
of the Docker platform.

To enable, configure, and build Docker images, use the new Build Containers view on the Build page in the
InstallAnywhere Advanced Designer.

The Build Containers view also enables you to search public and private Docker registries for base images—such
as those for Ubuntu, CentQS, Java, and MySQL—and pull them into your Docker images. You can also specify
installers that you want to be run on your Docker images.

To customize or further fine-tune the creation of Docker images, advanced users have the ability to edit the
Dockerfile—the set of commands that tells the Docker engine how to generate a Docker image—that
InstallAnywhere creates as you configure Docker settings in your project; this capability is in the Build Containers
view.

A new -dockerContainerMode command-line build parameter is available for building Docker containers.
To learn more, see:

® (Creating Docker Containers

® Requirements for Docker Support

® About Docker

1A-2021-UG00 InstallAnywhere 2021 User Guide



Chapter 1 InstallAnywhere 2021 SP1 Help Library
What Was New in Earlier Versions of InstallAnywhere

® Components of the Docker Platform

® Advantages of Using Docker Containers

® Enabling Docker Support

® Working with Docker Container Configurations

® Configuring Docker Engine Settings

® Selecting the Base Image for Your Docker Container

® Selecting the Installers that You Want to Include in Your Docker Container
e Editing the Dockerfile Directly

® Building a Docker Container

® Build Containers View

® Build Command-Line Arguments

Support for Deploying Web Applications to Local or Remote IBM WehSphere Servers

InstallAnywhere Premier Edition offers improvements for deploying Web applications (.ear or .war) to IBM
WebSphere servers.

Enabling End Users to Specify Connection Information for WebSphere Servers

Now you can add to your projects run-time panels or consoles that enable end users to specify settings for
WebSphere servers before deploying Web applications to these servers. For example, you can let end users
specify information such as the local or remote WebSphere server host where they want to deploy the Web
application.

To add the new run-time panels to a project, add the WebSphere Runtime Deployment panel or console actions.
These actions are available for the Pre-Install view on the Sequence page in the InstallAnywhere Advanced
Designer.

By default, these new run-time panels and consoles use variables such as $WEBSPHERE_DEPLOYMENT_OPTION$
and $WEBSPHERE_HOSTNAMES$ for storing the values that end users enter.

To learn more, see:

® Specifying Which Deployment Options to Support for IBM WebSphere Servers
® Deploying Web Applications (WAR and EAR Archives) to Servers

® Enabling End Users to Specify IBM WehSphere Server Information

e Deploy WAR/EAR Archive Action

® WebSphere Runtime Deployment Panel Action

® WebSphere Runtime Deployment Console Action

IBM WebSphere 7, 8, and 8.5 Support

InstallAnywhere now has support for deploying Web applications to WebSphere 7, 8, and 8.5 servers.
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Expanded Support for Connecting to IBM DB2, Microsoft SQL Server, and PostgreSQL Databases and
Running SQL Scripts

InstallAnywhere Premier Edition offers several improvements for connecting to IBM DB2, Microsoft SQL Server,

and PostgreSQL databases and running SQL scripts.

Enabling End Users to Specify Connection Information for Local and Remote Servers

Now you can add to your projects run-time panels or consoles that enable end users to specify connection
information such as the name of the local or remote server, as well as the credentials that should be used to
connect to the server through server authentication. In addition, you can optionally enable end users to test the
connection information that they entered.

To add the new run-time panels and consoles to a project, add the Choose Database Connection panel or console
actions. These actions are available for the Pre-Install view on the Sequence page in the InstallAnywhere
Advanced Designer.

By default, these new run-time panels and consoles use variables such as $0B_NAME_VARIABLE$ and
$DB_SERVERHOST_VARIABLES for storing the values that end users enter.

To learn more, see:
® Enabling End Users to Specify Database Connection Information
® Choose Database Connection Panel Action

® Choose Database Connection Console Action

Support for Creating Databases on Target Systems

The Run SQL Script action now optionally supports the creation of Microsoft SQL Server and PostgreSQL
databases on target systems. The Properties Customizer that is displayed when you select this action in the
Install view on the Sequence page has a Create Database check box that you can use to indicate whether to
create the database at run time.

For more information, see the following:
® Running a SQL Script

® Run SQL Script Action

® Hosts View

® Database Server Host Settings

IBM DB2 10.1 and 10.5 Support

InstallAnywhere now has support for managing IBM DB2 10.1 and 10.5 databases, as well as IBM DB2 9.0 and
9.7 databases.

Microsoft SQL Server 2008 R2, 2012, and 2014 Support

InstallAnywhere now has support for managing Microsoft SQL Server 2008 R2, 2012, and 2014 databases.
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Support for SHA-2 Digital Certificates

InstallAnywhere now enables you to use digital certificates that use the SHA-2 hashing algorithm for signing your
Windows-based installers (the installer .exe file, as well as the installer launcher and the uninstaller launcher) at
build time.

SHA-256 is favored over SHA-1, which is being deprecated because of the potential for security vulnerabilities.
Microsoft announced that Windows will stop trusting items that were signed and timestamped with SHA-1
certificates after January 1, 2016. In addition, certification authorities-the organizations that issue certificates-
are phasing out the creation of SHA-1 certificates. Thus, it is recommended that you replace any SHA-1
certificates in your InstallAnywhere projects with SHA-2 certificates. For the latest information and more specific
details, check with your certification authority.

If your project is configured to sign with a SHA-2 certificate, InstallAnywhere uses a SHA-2 hash in the signature
of the files that it signs at build time. If your project is configured to sign with a SHA-1 certificate, InstallAnywhere
generates a build error: either 813 (a SHA-1 certificate is configured in the project) or 814 (a SHA-1 certificate is
configured in the project and a timestamp server is not being used for signing).

To learn more, see Digitally Signing Windows-Based Installers.

Support for the Latest Platforms

InstallAnywhere now supports the following platforms for running installer run-time environment, as well as for
the InstallAnywhere the authoring environment:

® Windows 10 (x86 and x64)

® Red Hat Enterprise Linux 7.1 (desktop edition; x64)
® Red Hat Enterprise Linux 7 (zSeries)

® (OpenSUSE Linux 13.2 (desktop edition; x64)

® SUSE Linux Enterprise 12 (server edition; x64)

e Ubuntu 15.04 (desktop and server editions; x64)

e Ubuntu 14.10 (desktop and server editions; x64)

® Fedora 20 (desktop edition; x64)

® Solaris 11.2 (i86pc, SPARC)

Enhancements

Support for Transparent Backgrounds on Ul Panels

InstallAnywhere now enables you to make the main body area of each panel in the user interface of your installer
transparent. Previously, this area behind the main Ul text was always white.

To specify that you want the main body area to be transparent, select the new No Color option in the Inner Panel
Background Color setting. To access this setting, on the Installer Ul page, click the Look & Feel Settings view.
Then, in the General Ul Settings area, under the Installer Frame setting, the Inner Panel Background Color setting
is available with the new option.

For more information, see Look & Feel Settings View.

InstallAnywhere 2021 User Guide IA-2021-UGOO 55



Chapter 1 InstallAnywhere 2021 SP1 Help Library
What Was New in Earlier Versions of InstallAnywhere

Ability to Change the Text Color of the Installer Steps That the Installer Ul Shows for Progress

InstallAnywhere now enables you to customize the font color that is used to display the text of the installer steps
that is included on the left side of the installer user interface.

To specify the color, use the Look & Feel Settings view on the Installer Ul page. In the List of Labels for Installer
Steps setting, click the Installer Step Label settings button; the Installer Steps dialog box opens. On this dialog
box, click the Icons and Fonts button. The Choose Label Settings dialog box opens. To change the font color of the
text for the installer steps, click the Font Color button.

To learn more, see the following:
® (Choose Label Settings Dialog Box

® Look & Feel Settings View

Enhanced Show Message Dialog Action

The Show Message Dialog action has been enhanced. One of the new settings that you can configure for this Pre-
Install action is a check box called Cancel and Exit on ESC or X. If you want the installer to cancel and exit the
installation if the end user presses the Escape button or clicks the Close button (X) on the message dialog, select
this check box.

This check box is cleared by default.

For more information, see Show Message Dialog Action.

See Also
Upgrading from Earlier InstallAnywhere Versions

What’s New in InstallAnywhere 2014 SP1

InstallAnywhere 2021 SP1

InstallAnywhere offers expanded platform support. It also resolves a number of issues.

Expanded Platform Support

InstallAnywhere now supports the following platforms for the installer run-time environment, as well as for the
InstallAnywhere authoring environment:

® Red Hat Enterprise Linux 7
® (OpenSUSE Linux 13.1 (x86 and x64)
® SUSE Linux Enterprise 11 SP3 (x64)

® (S X Yosemite (10.10)

Changes to Authentication and Code-Signing Support for 0S X-Based Installers

Improvements have been made to the authentication and code-signing support for OS X-based installers. End
users can now successfully run code-signed installers (as well as uninstallers) with authentication support on
systems that have 0S X 10.8 or later.
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Flexible Methods for Code Signing

InstallAnywhere now supports two different methods of code signing:

InstallAnywhere performs the code-signing step at build time on the InstallAnywhere build machine—The
InstallAnywhere user has access to the Developer ID Application certificate and, in the InstallAnywhere project,
configures the Code Signing settings (the certificate location and the keystore password). At build time,
InstallAnywhere code signs the appropriate output files.

The InstallAnywhere build output is code signed on a designated code-signing machine—The InstallAnywhere
user builds an unsigned installer on the build machine. The build output is then code signed on a secure code-
signing machine that has the Developer ID Application certificate. Note: A limitation of this method is that it is not
possible to sign the uninstaller; therefore, the resulting uninstaller cannot be used to uninstall the product. The
only way to remove a product whose installer was code signed using this method is to drag it to the Trash.

New Tool for Code Signing the Helper Tool

When you configure your project to include authentication support, InstallAnywhere adds a helper tool to your
installer. The helper tool is the file that is used to launch the installer or uninstaller with elevated privileges. The
helper tool must be code signed with the same Developer ID Application certificate that you will be using to sign
your installer.

A new Prepare the Helper Tool utility is available when InstallAnywhere is installed on an 0OS X-based system. You
can use this utility on your build machine to sign the helper tool, or you can copy the utility to your designated
code-signing machine, where you can then sign the helper tool.

Once you have signed the helper tool, you can copy the signed helper tool to all of your OS X-based build
machines.

Support for Version 2 Signatures

InstallAnywhere now has support for creating version 2 signatures for 0S X-based systems. All code signing must
be done on systems that are running OS X 10.9 or later. Version 1 signatures, which are created by earlier
versions of OS X, are not recognized by Gatekeeper on systems with OS X 10.9 and later and are considered
obsolete. Files that are signed with version 2 signatures will work on OS X 10.8 and later.

Requirements for Code Signing

The following requirements must be met for code signing 0S X-based installers:
® The 0S X-based installer must be built on an 0S X-based system.
® All code signing must be done on systems that are running 0S X 10.9 or later.

e A Developer ID Application certificate must be used to sign the files. The certificate should be added to the
login keychain—not the system keychain—on the machine that is going to be used for code signing, and the
same user account that was used to add the certificate to the login keychain should be used to sign files.

e [f you plan on performing builds through the command-line console, ensure that the certificate has been
granted access to be used by all applications.

® Ensure that the latest Xcode IDE and all of its default SDKs are installed on the machine that is going to be
used for code signing.

For additional details about the authentication and code-signing support for 0S X-based systems, see the
following:
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® About Authentication and Code-Signing Support for OS or 0S X-Based Installers

® Code-Signing Methods for OS or 0OS X-Based Installers

® Requirements for Code-Signing Support for OS or 0OS X-Based Installers

® Adding the Code-Signing Capability to Your InstallAnywhere Build Machines or Code-Signing Machines

® Code Signing Your OS or OS X-Based Installers and Including Authentication Support

e® \Verifying that Your Code-Signing Output Files Are Working as Expected on OS or OS X-Based Target Systems
® Troubleshooting Tips for Code-Signing and Authentication Support for 0S or 0S X-Based Target Systems

® Prepare the Helper Tool Dialog Box

See Also
Upgrading from Earlier InstallAnywhere Versions

What’s New in InstallAnywhere 2014
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InstallAnywhere 2021 SP1

New Features

InstallAnywhere includes the following new features.

Ability to Create Upgrades that Uninstall the Earlier Version If Present Before Installing the New
Version

InstallAnywhere includes support for creating upgrades. At run time, if an earlier version of the product is present
on target systems, it is uninstalled, and then the new version is installed. If an earlier version is not present, the
installer installs the new version.

To configure settings for your upgrade, use the new Upgrades view, which is available from the Project page.

Note that a requirement for upgrade support is that the base version of the product must have been installed with
silent mode enabled. That is, the uninstaller must be capable of silently uninstalling the earlier version.

This feature is available in the Premier edition of InstallAnywhere.
To learn more, see:

® Updating Applications

® Requirements for Upgrade Support

® (Creating an Upgrade

® Enabling Upgrade Support

® Configuring Upgrade Settings

e Detecting Installed Earlier Versions that Need to Be Updated
® Adding Upgrade-Specific Actions to Sequences

® Special Considerations for Upgrade Support

® Upgrades View
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® Manage Upgrade Configurations Dialog Box

Updated Authentication Support for Apple 0S X

If you want your OS X-based installers and uninstallers to install files to and remove files from locations where
write permissions are restricted for standard users, you can configure your project to require authentication. This
support has been updated for 0OS X 10.8 and later systems. When authentication is required and standard users
who are not root users or administrative users with adequate privileges try to launch your installer or uninstaller,
they are prompted to enter an administrator name and password in order to proceed.

To indicate whether you want to require authentication for your 0S X-based installers and uninstallers, use the
settings in the Authentication category in the Mac 0S X area (Project page > Platforms view).

This feature is available in the Premier edition of InstallAnywhere.
To learn more, see:
® Requiring Elevated Privileges for OS or 0S X-Based Installers and Uninstallers

® Platforms View

Expanded Support for Connecting to MySQL Servers and Running SQL Scripts

InstallAnywhere Premier Edition offers several improvements for connecting to MySQL servers and running SQL
scripts.

Enabling End Users to Specify Connection Information for Local and Remote Servers

Now you can add to your projects run-time panels or consoles that enable end users to specify connection
information such as the name of the local or remote server, as well as the credentials that should be used to
connect to the server through server authentication. In addition, you can optionally enable end users to test the
connection information that they entered.

To add the new run-time panels and consoles to a project, add the Choose Database Connection panel or console
actions. These actions are available for the Pre-Install view on the Sequence page in the InstallAnywhere
Advanced Designer.

By default, these new run-time panels and consoles use variables such as $0B_NAME_VARIABLE$ and
$DB_SERVERHOST_VARIABLE$ for storing the values that end users enter.

To learn more, see:
® Enabling End Users to Specify Database Connection Information
® Choose Database Connection Panel Action

® Choose Database Connection Console Action

Support for Creating Databases on Target Systems

The Run SQL Script action now optionally supports the creation of databases on target systems. The Properties
Customizer that is displayed when you select this action in the Install view on the Sequence page has a new
Create MySQL Database check box that you can use to indicate whether to create the database at run time.

Note that some of the connection-related settings (such as Server Host and Server Port) that were previously
displayed when the database host was selected in the Hosts view on the Organization page have been moved to
a new tab at the bottom of the view for the Run SQL Script action.
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For more information, see the following:
® Running a SQL Script

® Run SQL Script Action

® Hosts View

® Database Server Host Settings

MySQL 5.5 and 5.6 Support

InstallAnywhere now has support for managing MySQL 5.5 and 5.6 databases.

Expanded Documentation on Managing SQL Servers

The documentation on managing SQL servers has been expanded. It now explains how to include the appropriate
drivers for connecting to SQL databases and offers additional how-to information. For details, see:

® Managing Database Servers

® Adding a SQL Database Host to Your Project

® Including JDBC Drivers for Connecting to SQL Databases
® Obtaining DB2 Drivers

® (Obtaining a MySQL Driver

® (Obtaining an Oracle Driver

® (Obtaining a Generic JDBC Driver

Support for Deploying Web Applications to Local or Remote Apache Tomcat Servers

InstallAnywhere Premier Edition offers improvements for deploying Web applications to Tomcat servers.

Enabling End Users to Specify Connection Information for Tomcat Servers

Now you can add to your projects run-time panels or consoles that enable end users to specify settings for
Apache Tomcat servers before deploying Web applications to these servers. For example, you can enable end
users to choose between deploying applications to local or remote Tomcat servers. You can also let end users
specify information such as the path on the local Tomcat server where they want to deploy the Web application or
the name of the remote Tomcat server.

To add the new run-time panels to a project, add the Tomcat Runtime Deployment panel or console actions.
These actions are available for the Pre-Install view on the Sequence page in the InstallAnywhere Advanced
Designer.

By default, these new run-time panels and consoles use variables such as $TOMCAT_DEPLOYMENT_OPTION$ and
$TOMCAT_SERVER_PATHS$ for storing the values that end users enter.

To learn more, see:
e Specifying Which Deployment Options to Support for Apache Tomcat Servers
® Deploying Web Applications (WAR and EAR Archives) to Servers

® Enabling End Users to Specify Apache Tomcat Server Information
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e Deploy WAR/EAR Archive Action
® Tomcat Runtime Deployment Panel Action

® Tomcat Runtime Deployment Console Action

Apache Tomcat 7 and 8 Support

InstallAnywhere now has support for deploying Web applications to Tomcat 7.0.x and 8.0 servers.

Red Hat Enterprise Linux 6.5 and Ubuntu 14.04 Support

InstallAnywhere now supports the following platforms for the installer run-time environment, as well as for the
InstallAnywhere authoring environment:

® Red Hat Enterprise Linux 6.5 (desktop and server editions; x64)

e Ubuntu 14.04 (x64)

Enhancements

New Variable for the Browse for CD Button on Some Apple 0S X-Based Systems

The Change Media run-time panel has a Browse button that should enable end users to browse to the next
installation media that they want to use. Apple 0S X-based systems that use Oracle Java 7 with an update earlier
than update 45 do not support built-in resources for the button on that panel, so the browse button does not
work as expected. If you want to use Swing resources instead of built-in resources for that panel and avoid
problems with the browse button, you can set the new
ia.mac.filechooser.substituteSwingInsteadOfNativeForOlderJRE7 variable to true for installers that target 0S X-
based systems that use Oracle Java 7 with an update earlier than update 45. The default value for this property is
false.

To set ia.mac.filechooser.substituteSwinglnsteadOfNativeForOlderJRE7 to true, specify the following command-
line parameter in your project (Project page > JVM Settings view > Installer Settings tab > Optional Installer
Arguments):

-Dia.mac.filechooser.substituteSwingInsteadOfNativeForOlderJRE7=true

To learn more, see $IA_BROWSE_FOLDERS$ Variable.

Enhanced Support for Registering Windows Services

The Register Windows Service action has a new Service Description setting that lets you specify the description of
the Windows service that your installer is registering on Windows-based target systems. The description is
displayed is displayed in the service control manager’s Description column. It is also displayed in the Description
box on the General tab of the service’s Properties dialog box.

See Also
Upgrading from Earlier InstallAnywhere Versions
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What’s New in InstallAnywhere 2013
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InstallAnywhere 2021 SP1

New Features

InstallAnywhere includes the following new features.

Redesigned User Interface for the Advanced Designer

The Advanced Designer in InstallAnywhere has been overhauled to enhance usability, increase productivity, and
update the look and feel for the design-time environment.

Following are highlights for the redesign.

Revamped, Streamlined Navigation

The Advanced Designer has two main navigational elements:

® The primary navigational element is the horizontal row of buttons near the top of the InstallAnywhere
interface, directly below the menu bar. You can click these buttons to open various pages in the Advanced
Designer. This navigational element has buttons for Project, Installer Ul, Organization, Sequence, and Build.

® The secondary navigational element is the vertical column of buttons on the left side of the InstallAnywhere
interface; these buttons are links to the various views in the Advanced Designer. The list of buttons in this
area changes, depending on which page in the Advanced Designer is currently open. For example, when the
Organization page is open, the vertical navigation area on the left contains buttons that point to views such
as Install Sets, Features, and Components. When the Build page is open, the buttons on the left point to the
Build Installers and Build Appliances views.

Previously, both levels of the navigation were positioned along the left side of the Advanced Designer, in two
separate vertical columns. The primary navigational element was the first vertical column in the Advanced
Designer, and this level of navigation represented a Ul element that was previously called tasks. The secondary
navigational element was the second column of links, which were referred to as subtasks.

Also as part of the navigation changes, the primary navigation element has been streamlined to make it easier to
navigate the Advanced Designer. The Pre-Install, Install, Post-Install, Pre-Uninstall, Uninstall, and Post-Uninstall
areas (which enable you to define and schedule files to be installed, actions to be launched, and panels to be
displayed) are now available as individual views on the new Sequence page. Previously, these areas were part of
the primary level of navigation.

The Help button is now a blue button with a question mark on it; it has been moved from the lower-left corner of
the Advanced Designer to the top-right corner. To launch the InstallAnywhere Help Library in your machine's
default Web browser, click this button.

To learn more, see:

® Advanced Designer Reference
® Project Page

® |[nstaller Ul Page

® (QOrganization Page

® Sequence Page
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® Build Page

New Default Start Mode: Advanced Designer Instead of Project Wizard

Although you can use the Project Wizard in InstallAnywhere to quickly create a basic installer, the Advanced
Designer—with its support for advanced installer configuration—is the area in InstallAnywhere where most
installation developers spend the majority of their time. Therefore, when you start InstallAnywhere, it now
launches the Advanced Designer by default. Previously, it opened the Project Wizard by default.

The Advanced Designer has a setting that lets you specify which mode you want to use when starting
InstallAnywhere. You can change the preferred startup mode at any time: On the Edit menu, click Preferences.
The InstallAnywhere Preferences dialog box opens. On the General tab of this dialog box, use the InstallAnywhere
Startup setting to specify whether you want InstallAnywhere to start in Project Wizard mode or Advance Designer
mode.

To switch from the Advanced Designer to the Project Wizard: On the File menu, click Project Wizard. This
functionality was previously available from a Start Wizard command on the Wizard menu in the Advanced
Designer.

To switch from the Project Wizard to the Advanced Designer, click the Advanced Designer button on any panel of
the Project Wizard.

New Grid-Based Format for Settings in Some Views of the Advanced Designer

Some of the views on the Project page and on the Installer Ul page in the Advanced Designer have been
consolidated and reorganized into two-column grids to improve productivity and usability. The new grid format
shows the names of the settings in the left column and their corresponding values in the right column. The grid in
the new General Settings view on the Project page contains the settings that were previously displayed on the
Info, Description, File Settings, Log Settings, and Software Tag subtasks. The Platforms Settings view on the
Project page contains the settings that were previously displayed in different areas of the Platforms subtask. In
addition, the Look & Feel view on the Installer Ul page contains the setting that were previously displayed in
different areas of the Look & Feel subtask.

The settings in the new grids are organized into different categories. You can expand or collapse the category
rows to show or hide each part of the grid that contains the settings within a particular category.

For more information, see:
® (General Settings View
® Platforms View

® ook & Feel Settings View

New Inline Help Panes in Some Views of the Advanced Designer

The new grid-based interface that is displayed for some of the views on the Project page and the Installer Ul page
includes an inline help pane. The content in this help pane changes, depending on what setting in the grid is
selected. For example, if you select the Repair Mode Log setting in the General Settings view, the help pane at the
bottom of the view shows help text that pertains to the Repair Mode Log setting. If you select a different setting
in this view, the help pane displays help text about that particular setting.

The inline help is available in the General Settings view and the Platform Settings view on the Project page of the
Advanced Designer. It is also available in the Look & Feel view on the Installer Ul page of the Advanced Designer.
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Usability Improvements for Sequencing Actions, Panels, and Other Items

InstallAnywhere now makes it easier to sequence and configure actions, panels, and other items in the Pre-
Install, Install, Post-Install, and other views on the Sequence page in the Advanced Designer. If you are working
with a long list of actions in the visual tree area that is displayed at the top of one of these views, you can
temporarily hide the settings in the bottom of the view; this enables you to see more of the visual tree at once on
the screen, without requiring you to scroll vertically. When you are done scheduling the actions and other items,
you can have InstallAnywhere revert back to displaying the settings in the bottom of the view; this enables you to
configure the settings for whichever action or other item is selected in the visual tree.

To hide the settings, click the new Collapse button; this button is on the right side of the screen, under the visual
tree. When you click this button, InstallAnywhere hides the Properties Customizer box at the bottom of the
screen, and changes the Collapse button into an Expand button. To make it possible to see and configure the
action settings, click this Expand button.

For more details, see Sequence Page.

Usability Improvements for Managing Build-Related Settings for Installers and Virtual Appliances

The Build Installers view in the Advanced Designer includes some enhancements that make it easier to manage
build configurations for installers. The Build Appliances view includes some similar enhancements for managing
appliance configurations for virtual appliances.

The layout for the build configuration controls at the top of the Build Configurations tab in the Build Installers view
has been revised to leave more vertical space for other areas of this page. As a result, it is now easier to use this
Configurations tab to configure the settings for build targets; less vertical scrolling is required. To make this
possible, the view has four new small buttons: Add Build Configuration, Copy Build Configuration, Rename Build
Configuration, and Remove Build Configuration. These new buttons have icons, and they are positioned in the
same row as the Select Build Configuration list and the Add to project build check box. The new buttons replace
the row of old buttons that was previously located below the Select Build Configuration list and the Add to project
build check box.

Similarly, the appliance configuration controls at the top of the Appliance Configuration tab in the Build
Appliances view has four new small buttons: Add Appliance Configuration, Copy Appliance Configuration,
Rename Appliance Configuration, and Remove Appliance Configuration. These new buttons replace the row of old
buttons.

The Build Installers view and the Build Appliances view are available on the Build page in the Advanced Designer.
To learn more, see:

® Build Page

® Build Installers View

e Build Appliances View

Support for the Latest Platforms

InstallAnywhere supports the following platforms for running InstallAnywhere (the authoring environment):
® Windows 8.1

® Windows Server 2012 R2

® Red Hat Enterprise Linux 6.4 (desktop and server editions; x86 and x64)

® SUSE Linux 10 (x86)
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® (OpenSUSE Linux 11.2,11.3,11.4,12.1, 12.2, and 12.3 (x86 and x64)
® SUSE Linux Enterprise 11 SP2 (x64)
e Ubuntu 13.04 (desktop and server editions; x86 and x64)

® Fedora 18 and 19 (desktop and server editions; x86 and x64)

Ability to Create Virtual Appliances for Multi-tier Applications

InstallAnywhere includes support for creating multi-tier virtual appliances for VMware vCenter servers. You can
create this sort of virtual appliance to enable your enterprise customers to quickly get started using your multi-
tier application in their own virtualization environments, without requiring them to spend a lot of time working on
complex configuration tasks.

The VM Configuration tab in the Build Appliances view on the Build page is where you define and configure one or
more tiers for your virtual appliance. Each InstallAnywhere project contains a single VM tier by default. To perform
other tasks such as add an additional tier to your project, use the new buttons (Add VM Tier, Copy VM Tier,
Rename VM Tier, and Delete VM Tier) near the top of the VM Configuration tab. To indicate which tier in your
project you want to configure, select the appropriate tier in the new Select VM Tier list on this tab.

Previously, InstallAnywhere included support for only single-tier virtual appliances.

The project automation APIs have been expanded to include support for multi-tier virtual appliances. A
VirtualMachineTier class and a VirtualMachineCollectionEntity interface are now available. Each virtual machine
is now added to a virtual appliance through virtual machine tiers. Previously, each virtual machine was added
directly to the virtual appliance.

A new project automation APl sample (MultiTierVirtualAppliance_Test.java) is installed with InstallAnywhere
(InstallAnywhere Installation Directory\project-auto\sample\src\com\ia\projauto\samples). This Java file
demonstrates how to create a multi-tier virtual appliance through project automation APIs.

IABankingApplication.iap_xml is a sample InstallAnywhere project that you can use to explore InstallAnywhere’s
support for multi-tier virtual appliances. This project file, along with application files, are installed with
InstallAnywhere (InstallAnywhere Installation Directory\lABankingApplication). The sample project is
configured to create a three-tier virtual appliance.

This feature is available in InstallAnywhere Premier Edition with Virtualization and Cloud.
For more information, see:

® Managing Multiple Tiers for a Virtual Appliance

® Manage VM Tiers Tab

® VM Configuration Tab

® Project Automation API Code Samples

® Using the IABankingApplication Sample for Creating Multi-Tier Virtual Appliances

Expanded Operating System Support for Creating VMware vSphere/vCenter Virtual Appliances

InstallAnywhere now enables you to create VMware vSphere/vCenter virtual appliances for an expanded list of
operating systems:

® Cent0S 6.2 and 6.3 (32-bit and 64-bit)

® Red Hat Enterprise Linux 6.4 (32-bit and 64-bit)
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® Red Hat Enterprise Linux 6.3 (64-bit)

® Ubuntu 13.04 (32-bit and 64-bit)

e Ubuntu 12.10 (32-bit and 64-bit)

e Ubuntu 12.04 (32-bit and 64-bit)

® Ubuntu 11.10 (32-bit and 64-bit)

Previously, only 32-bit versions of Cent0S 6.2, Cent0S 6.3, Ubuntu 11.10, and Ubuntu 12.04 were supported.
This feature is available in InstallAnywhere Premier Edition with Virtualization and Cloud.

For a complete list of supported hypervisors and operating systems for virtual appliances, see Supported
Hypervisors and Platforms for Virtual Appliances.

Ability to Create Virtual Appliances from Existing Virtual Machines

InstallAnywhere now has support for creating a virtual appliance from an existing VMware vSphere 5 server,
without requiring you to use a predefined or custom virtual machine (VM) template (a preinstalled virtual machine
disk that contains the operating system and any required operating system packages). This capability makes it
easier to quickly get started building virtual appliances for VMware vSphere servers.

To specify an existing VM that you want to use for your vSphere appliance, specify the connection information in
the Connection Settings area of the Appliance Configuration tab, which is available in the Build Appliances view
on the Build page. Once you have configured connection information, switch to the VM Configuration tab, and
click the new Choose a VM button. The Choose a VM button is next to the new Chosen VM list.

When you click the new Choose a VM button, the Choose a VM Wizard opens, enabling you to specify whether you
want to create your virtual appliance based on a specific VM or a specific VM snapshot that is running on an
VMware vSphere/vCenter 5 server. Optionally, you can also use this wizard to select a specific VM template that
you want to use.

Previously, in order to create a virtual appliance for VMware vSphere 5 server, it was necessary to first specify the
VM template that you wanted to use for your virtual appliance. You could use one of the ones that is available for
InstallAnywhere, or you could create your own custom VM template in InstallAnywhere.

This feature is available in InstallAnywhere Premier Edition with Virtualization and Cloud.
To learn more, see:
e Selecting a VM for a VMware Virtual Appliance

® Choose a VM Wizard

Ability to Build Pure 64-Bit Installers for 64-Bit Windows-Based Systems

Windows Server Core supports disabling 32-bit Windows-on-Windows (WOW64) support. As this configuration
becomes more popular, you may want to ensure that your 64-bit applications can install without any reliance on
32-bit functionality. To make this possible, InstallAnywhere now enables you to build pure 64-bit installers for
Windows-based target systems; these installers can be run on 64-bit Windows-based systems that do not have
WOW64 functionality. They contain 64-bit self-extractors, LaunchAnywheres, and VM packs, as needed. They can
install to 64-bit file and registry locations and install 64-bit Windows services as required.
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To create a 64-bit Windows-based installer, use the new Windows_Pure_64_Bit build target that is available on
the Build Targets tab in the Build Installers view. You can use this build target to configure options such as
whether you want to bundle a VM pack in your installer. If you specify that you want to include a VM pack, only
64-bit VM bundles are available for selection.

This feature is available in InstallAnywhere Premier Edition.
To learn more, see:
® Targeting 32-Bit and 64-Bit Windows-Based Systems

® (Creating Pure 64-Bit Installers for 64-Bit Windows-Based Target Systems

New build.exe Command-Line Parameters

If you use the command-line tool build.exe to build installers, you can use the following platform-related
arguments for adding or removing pure 64-bit Windows-based targets:

® w64 or W64—Pure 64-bit Windows-based installer without VM

® w64v or W64V—Pure 64-bit Windows-based installer with VM

® w64c or We4C—Pure 64-bit Windows-based installer without VM and with console launcher option
® w6B4g or W64G—Pure 64-bit Windows-based installer without VM and with graphical launcher option
® w6B4vc or W64VC—Pure 64-bit Windows-based installer with VM and with console launcher option

® wB4vg or W64VG—Pure 64-bit Windows-based installer with VM and with graphical launcher option

To add one of the aforementioned build targets, precede the argument with a plus sign (+); to remove one of the
aforementioned build targets, precede the argument with a minus sign (-). For example, to build a pure 64-bit
Windows-based installer with VM and with the graphical launcher option, pass either of the following to
build.exe:

+we4vg
+HW64VG

For a list of all of the supported build.exe command-line parameters, see Build Command-Line Arguments.

New Platform Attributes for the Build Properties XML File

If you use a build properties XML file to pass build properties to build.exe, you can use the following new
platform attributes to define a pure 64-bit Windows-based build target:

® BuildWindows64WithVM="<true/false>"

® BuildWindows64WithoutVM="<true/false>"

e Windows64VMpackLocation="<path_to_file>"
® Windows64DefaultUl="<Silent/GUl/Console>"

For a list of all of the supported properties for the build properties XML file, see Supported Properties in the
BuildProperties.xml File.
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New Properties for the .properties File

If you use a .properties file to pass build properties to build.exe, you can set a new property to define the default
Ul mode for pure 64-bit Windows-based build targets. The new property is default.ui.mode.windows64 property;
you can set it equal to Silent, Console, or GUI. For example:

default.ui.mode.windows64=GUI

The following True/False properties are also new:

® config.1l.com.zerog.ia.build.platform.windows64.novm

e config.1l.com.zerog.ia.build.platform.windows64.vm

e config.1l.com.zerog.ia.build.vmpack.windows64.path

For a list of all of the supported properties for the .properties file, see Supported Properties in the

buildproperties.properties File.

New Attribute Values for the InstallAnywhere Ant Task

If you use Ant to build installers, you can use the following new attributes in your InstallAnywhere Ant task for
defining pure 64-bit Windows-based build targets.

® BuildWindows64WithVM—Use this attribute with True or False values to indicate whether you are building a
pure 64-bit Windows-based installer with VM.

® BuildWindowsB64WithoutVM—Use this attribute with True or False values to indicate whether you are building
a pure 64-bit Windows-based installer without VM.

® Windows64DefaultUl—Use one of the following values to specify the default Ul mode: Silent, Console, or GUL.

® Windows64VMPackLocation—Use this attribute to specify the path of the VM pack for pure 64-bit Windows-
based build targets.

For a list of supported parameters for the InstallAnywhere Ant task, see InstallAnywhere Ant Task Reference.

Support for Digitally Signing Installers for Windows-Based Build Targets

InstallAnywhere includes support for digitally signing your Windows-based installers (the installer .exe file, as
well as the installer launcher and the uninstaller launcher) at build time. If you want to digitally sign these
installers, use the Platforms Settings view on the Project page to configure digital signature information. In this
view, the Windows category contains some digital signing settings. This is where you specify the certificate file
(.pfx) that you want to use to sign your Windows-based installers. It is also where you specify the password for
the certificate and the timestamp server that you want to use.

As an alternative to specifying the actual certificate file, password, and timestamp server in the Platforms
Settings view, you can use build-time variables in these settings (that is, enclose the name of each variable within
at symbols: @variableName@). You can set build-time variables in the Variables view on the Project page, through a
.properties file, or through environment variables.

Note that the ability to digital sign Windows-based installers at build time requires that you are using
InstallAnywhere on a Windows-based system. If you try to build a Windows-based installer on a non-Windows
system, a build warning occurs, and InstallAnywhere does not sign the resulting installer.

To learn more, see:

® Digitally Signing Windows-Based Installers
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® Platforms View

Support for JRE 7 on 0S X 10.7.3 and Later

InstallAnywhere now has support for building 0S X-based installers that use JRE 7 at run time. InstallAnywhere
also has support for creating VM packs with Oracle JRE 7, as well as for bundling installers with Oracle JRE 7.

When you configure any OS X build target in the Build Installers view on the Build page, you now have several VM-
related options. You can specify whether the installer should search 0S X systems for the presence of Oracle JRE
7 or later, or for the presence of Apple JRE 6 or earlier; if the required JRE is not available, the installation fails
and exits. If multiple required versions of JRE are present, the installer uses the one that is set by the JRE_HOME
environment variable.

An OS X build target also lets you specify whether you want the installer to avoid searching OS X target systems
for a required JRE and instead use a specific bundled VM; if you choose to use a bundled VM instead of searching
for a required VM, specify which VM you want to bundle with the installer.

For more information, see:

® Defining Build Targets
® Build Targets Subtab

® (Creating JRE VM Packs
® JRE VM Pack Structure
® JRE VM Pack Properties

® Run-Time Behavior for LaunchAnywhere Files on OS and OS X-Based Systems

Support for Configuring the Windows Execution Level Now Available in All InstallAnywhere Editions

Support for configuring the Windows execution level is now available in the Professional (formerly known as
Standard) edition of InstallAnywhere. This capability lets you select the execution level that your installer launcher
requires for target systems that are running Windows Vista and later or Windows Server 2008 or later. To
configure the execution level of your Windows-based installers, select the appropriate option in the Windows
Execution Level setting in the Advanced Designer (Project page > Platforms view > Windows area).

Previously, this support was available only in the Premier (formerly known as Enterprise) edition of
InstallAnywhere.

To learn more, see Platforms View.

Support for Setting the field size for Add or Remove Programs Applet on Windows in all
InstallAnywhere Editions

Support for setting the field size is now available in the Professional (formerly known as Standard) edition of
InstallAnywhere. This new field Estimated size (in MB) is added under Projects > Platforms > Windows section for
all project types.

By default 'Estimated size(in MB)' field value will be blank. You can enter an estimated size of any value > 0 (Zero)
and <= 4194303(4TB).

Note = Cannot enter floating/decimal value for an estimated size.
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Support for Managing Windows-Based Services Now Available in All InstallAnywhere Editions

Support for managing Windows-based services is now available in the Professional (formerly known as Standard)
edition of InstallAnywhere. To manage a service in your installer, use the Sequence page in the Advanced
Designer to add any of the service-related actions to your project.

Previously, this support was available only in the Premier (formerly known as Enterprise) edition of
InstallAnywhere.

To learn more, see General Actions.

Support for Setting System Environment Variables Now Available in All InstallAnywhere Editions

Support for setting system environment variables on Windows-based and UNIX-based target systems is now
available in the Professional (formerly known as Standard) edition of InstallAnywhere. To set a system
environment variable, add the Set System Environment Variable action to a sequence through the Sequence page
in the Advanced Designer.

Previously, this support was available only in the Premier (formerly known as Enterprise) edition of
InstallAnywhere.

To learn more, see Install Actions.

Enhancements

Support for Displaying the Percentage Complete on the Install Progress Panel

The progress bar on the default Install Progress panel now shows the numeric percentage of the installation that
is complete. In addition, a new method is available for obtaining the percentage of the installation that is
complete:

public int getCurrentProgressPercentage();
Expanded Search Support for the Find Component in InstallAnywhere Registry Action on 64-Bit
Target Systems

A new Search in both 32-bit and 64-bit InstallAnywhere registries check box is available when you add the Find
Component in InstallAnywhere Registry act